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AMX Limited Warranty and Disclaimer
All products returned to AMX require a Return Material Authorization (RMA) number. The RMA number is 
obtained from the AMX RMA Department. The RMA number must be clearly marked on the outside of each 
box. The RMA is valid for a 30-day period. After the 30-day period the RMA will be cancelled. Any shipments 
received not consistent with the RMA, or after the RMA is cancelled, will be refused. AMX is not responsible 
for products returned without a valid RMA number.
Warranty Repair Policy
• AMX will repair any defect due to material or workmanship issues during the applicable warranty period at no cost to the AMX 

Authorized Partner, provided that the AMX Authorized Partner is responsible for in-bound freight and AMX is responsible for out-
bound ground freight expenses.

• The AMX Authorized Partner must contact AMX Technical Support to validate the failure before pursuing this service.

• AMX will complete the repair and ship the product within five (5) business days after receipt of the product by AMX. The AMX 
Authorized Partner will be notified if repair cannot be completed within five (5) business days.

• Products repaired will carry a ninety (90) day warranty or the balance of the remaining warranty, whichever is greater.

• Products that are returned and exhibit signs of damage or unauthorized use will be processed under the Non-Warranty Repair 
Policy.

• AMX will continue to provide Warranty Repair Services for products discontinued or replaced by a Product Discontinuance 
Notice.

Non-Warranty Repair Policy
• Products that do not qualify to be repaired under the Warranty Repair Policy due to age of the product or Condition of the 

product may be repaired utilizing this service.

• The AMX Authorized Partner must contact AMX Technical Support to validate the failure before pursuing this service.

• Non-warranty repair is a billable service.

• Products repaired under this policy will carry a ninety (90) day warranty on material and labor.

• AMX will notify the AMX Authorized Partner with the cost of repair, if cost is greater than the Standard Repair Fee, within five (5) 
days of receipt.

• The AMX Authorized Partner must provide a Purchase Order or credit card number within five (5) days of notification, or the 
product will be returned to the AMX Authorized Partner.

• The AMX Authorized Partner will be responsible for in-bound and out-bound freight expenses.

• Products will be repaired within ten (10) business days after AMX Authorized Partner approval is obtained.

• Non-repairable products will be returned to the AMX Authorized Partner with an explanation.

• See AMX Non-Warranty Repair Price List for minimum and Standard Repair Fees and policies.



Software License and Warranty Agreement
• LICENSE GRANT. AMX grants to Licensee the non-exclusive right to use the AMX Software in the manner described in this 

License. The AMX Software is licensed, not sold. This license does not grant Licensee the right to create derivative works of the 
AMX Software. The AMX Software consists of generally available programming and development software, product documenta-
tion, sample applications, tools and utilities, and miscellaneous technical information. Please refer to the README.TXT file on 
the compact disc or download for further information regarding the components of the AMX Software. The AMX Software is sub-
ject to restrictions on distribution described in this License Agreement. AMX Dealer, Distributor, VIP or other AMX authorized 
entity shall not, and shall not permit any other person to, disclose, display, loan, publish, transfer (whether by sale, assignment, 
exchange, gift, operation of law or otherwise), license, sublicense, copy, or otherwise disseminate the AMX Software. Licensee 
may not reverse engineer, decompile, or disassemble the AMX Software. 

• ACKNOWLEDGEMENT. You hereby acknowledge that you are an authorized AMX dealer, distributor, VIP or other AMX autho-
rized entity in good standing and have the right to enter into and be bound by the terms of this Agreement.

• INTELLECTUAL PROPERTY. The AMX Software is owned by AMX and is protected by United States copyright laws, patent 
laws, international treaty provisions, and/or state of Texas trade secret laws. Licensee may make copies of the AMX Software 
solely for backup or archival purposes. Licensee may not copy the written materials accompanying the AMX Software. 

• TERMINATION. AMX RESERVES THE RIGHT, IN ITS SOLE DISCRETION, TO TERMINATE THIS LICENSE FOR ANY REA-
SON UPON WRITTEN NOTICE TO LICENSEE. In the event that AMX terminates this License, the Licensee shall return or 
destroy all originals and copies of the AMX Software to AMX and certify in writing that all originals and copies have been 
returned or destroyed. 

• PRE-RELEASE CODE. Portions of the AMX Software may, from time to time, as identified in the AMX Software, include PRE-
RELEASE CODE and such code may not be at the level of performance, compatibility and functionality of the GA code. The 
PRE-RELEASE CODE may not operate correctly and may be substantially modified prior to final release or certain features may 
not be generally released. AMX is not obligated to make or support any PRE-RELEASE CODE. ALL PRE-RELEASE CODE IS 
PROVIDED "AS IS" WITH NO WARRANTIES.

• LIMITED WARRANTY. AMX warrants that the AMX Software (other than pre-release code) will perform substantially in accor-
dance with the accompanying written materials for a period of ninety (90) days from the date of receipt. AMX DISCLAIMS ALL 
OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH REGARD TO THE AMX SOFTWARE. THIS LIM-
ITED WARRANTY GIVES LICENSEE SPECIFIC LEGAL RIGHTS. Any supplements or updates to the AMX SOFTWARE, 
including without limitation, any (if any) service packs or hot fixes provided to Licensee after the expiration of the ninety (90) day 
Limited Warranty period are not covered by any warranty or condition, express, implied or statutory.

• LICENSEE REMEDIES. AMX's entire liability and Licensee's exclusive remedy shall be repair or replacement of the AMX Soft-
ware that does not meet AMX's Limited Warranty and which is returned to AMX in accordance with AMX's current return policy. 
This Limited Warranty is void if failure of the AMX Software has resulted from accident, abuse, or misapplication. Any replace-
ment AMX Software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. 
Outside the United States, these remedies may not available. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO 
EVENT SHALL AMX BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES 
FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER 
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THIS AMX SOFTWARE, EVEN IF AMX HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES/COUNTRIES DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITA-
TION MAY NOT APPLY TO LICENSEE.

• U.S. GOVERNMENT RESTRICTED RIGHTS. The AMX Software is provided with RESTRICTED RIGHTS. Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph ©(1)(ii) of The Rights in Technical Data and 
Computer Software clause at DFARS 252.227-7013 or subparagraphs ©(1) and (2) of the Commercial Computer Software 
Restricted Rights at 48 CFR 52.227-19, as applicable.

• SOFTWARE AND OTHER MATERIALS FROM AMX.COM MAY BE SUBJECT TO EXPORT CONTROL. The United States 
Export Control laws prohibit the export of certain technical data and software to certain territories. No software from this Site may 
be downloaded or exported (i) into (or to a national or resident of) Cuba, Iraq, Libya, North Korea, Iran, Syria, or any other coun-
try to which the United States has embargoed goods; or (ii) anyone on the United States Treasury Department's list of Specially 
Designated Nationals or the U.S. Commerce Department's Table of Deny Orders. AMX does not authorize the downloading or 
exporting of any software or technical data from this site to any jurisdiction prohibited by the United States Export Laws.

This Agreement replaces and supersedes all previous AMX Software License Agreements and is governed by 
the laws of the State of Texas, and all disputes will be resolved in the courts in Collin County, Texas, USA. For 
any questions concerning this Agreement, or to contact AMX for any reason, please write: AMX License and 
Warranty Department, 3000 Research Drive, Richardson, TX 75082.
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ESD Warning
ESD Warning

To avoid ESD (Electrostatic Discharge) damage to sensitive components, make sure you are properly 
grounded before touching any internal materials.

When working with any equipment manufactured with electronic devices, proper ESD grounding 
procedures must be followed to ensure people, products, and tools are as free of static charges as 
possible. Grounding straps, conductive smocks, and conductive work mats are specifically designed for 
this purpose. 

Anyone performing field maintenance on AMX AutoPatch equipment should use an appropriate ESD 
field service kit complete with at least a dissipative work mat with a ground cord and a UL listed 
adjustable wrist strap with another ground cord. These items should not be manufactured locally, since 
they are generally composed of highly resistive conductive materials to safely drain static charges, 
without increasing an electrocution risk in the event of an accident. ESD protective equipment can be 
obtained from 3M™, Desco®, Richmond Technology®, Plastic Systems®, and other such vendors.
1Epica DG Instruction Manual



Important Safety Information & Instructions
Important Safety Information & Instructions

When using and installing your AMX AutoPatch product, adhere to the following basic safety 
precautions. For more information about operating, installing, or servicing your AMX AutoPatch 
product, see your product documentation.

z Read and understand all instructions before using and installing AMX AutoPatch products.

z Use the correct voltage range for your AMX AutoPatch product.

z There are no user serviceable parts inside an AMX AutoPatch product; service should only be 
done by qualified personnel.

z If you see smoke or smell a strange odor coming from your AMX AutoPatch product, turn it 
off immediately and call technical support.

z For products with multiple power supplies in each unit, make sure all power supplies are 
turned on simultaneously.

z Use surge protectors and/or AC line conditioners when powering AMX AutoPatch products.

z Only use a fuse(s) with the correct fuse rating in your enclosure.

z Make sure the power outlet is close to the product and easily accessible.

z Make sure the product is on or attached to a stable surface.

z Turn off equipment before linking pieces together, unless otherwise specified in that product’s 
documentation.

z For safety and signal integrity, use a grounded external power source and a grounded power 
connector.

z Turn off and unplug an enclosure before adding or removing boards, unless otherwise 
specified in that product’s documentation.

z To avoid shock or potential ESD (Electrostatic Discharge) damage to equipment, make sure 
you are properly grounded before touching components inside an AMX AutoPatch product.
2 Epica DG Instruction Manual



Information et directives de sécurité importantes
Information et directives de sécurité 
importantes

Veuillez vous conformer aux directives de sécurité ci-dessous lorsque vous installez et utilisez votre 
appareil AMX AutoPatch. Pour de plus amples renseignements au sujet de l’installation, du 
fonctionnement ou de la réparation de votre appareil AMX AutoPatch, veuillez consulter la 
documentation accompagnant l’appareil.

z Lisez attentivement toutes les directives avant d’installer et d’utiliser les appareils AMX 
AutoPatch.

z Le voltage doit être approprié à l’appareil AMX AutoPatch.

z Les appareils AMX AutoPatch ne contiennent aucune pièce réparable par l’usager; la 
réparation ne doit être effectuée que par du personnel qualifié.

z Si de la fumée ou une odeur étrange se dégagent d’un appareil AMX AutoPatch, fermez-le 
immédiatement et appelez le Service de soutien technique.

z Veillez à ce que tous les blocs d’alimentation des appareils dotés de blocs d’alimentation 
multiples dans chaque unité soient allumés simultanément.

z Servez-vous de protecteurs de surtension ou de conditionneurs de lignes à courant alternatif 
lorsque vous mettez les appareils AMX AutoPatch sous tension.

z Placez uniquement des fusibles de calibre exact dans les boîtiers.

z Veillez à ce que la prise de courant soit proche de l’appareil et facile d’accès.

z Veillez à ce que votre appareil AMX AutoPatch soit installé sur une surface stable ou qu’il 
y soit fermement maintenu.

z Fermez toutes les composantes de l’équipement avant de relier des pièces, à moins 
d’indication contraire fournie dans la documentation de l’appareil.

z Par mesure de sécurité et pour la qualité des signaux, servez-vous d’une source d’alimentation 
externe mise à la terre et d’un connect d’alimentation mis à la terre.

z Fermez et débranchez le boîtier avant d’ajouter ou d’enlever des plaquettes, à moins 
d’indication contraire fournie dans la documentation du appareil.

z Pour éviter les chocs ou les dommages éventuels causés à l’équipement par une décharge 
électrostatique, veillez à ce le dispositif oit bien relié à la terre avant de toucher les 
composantes se trouvant à l’intérieur d’un appareil AMX AutoPatch.
3Epica DG Instruction Manual



Notices
Notices

Copyright Notice

AMX© 2009 (Rev D), all rights reserved. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, 
recording, or otherwise, without the prior written permission of AMX. Copyright protection claimed 
extends to AMX hardware and software and includes all forms and matters copyrightable material and 
information now allowed by statutory or judicial law or herein after granted, including without 
limitation, material generated from the software programs which are displayed on the screen such as 
icons, screen display looks, etc. Reproduction or disassembly of embodied computer programs or 
algorithms is expressly prohibited. 

Liability Notice

No patent liability is assumed with respect to the use of information contained herein. 

While every precaution has been taken in the preparation of this publication, AMX assumes no 
responsibility for error or omissions. No liability is assumed for damages resulting from the use of the 
information contained herein. 

Further, this publication and features described herein are subject to change without notice.

Lithium Batteries Notice

Switzerland requires the following notice for products equipped with lithium batteries. This notice is not 
applicable for all AMX equipment.

Upon shipment of the products to Switzerland, the requirements of the most up-to-date Swiss Ordinance 
Annex 4.10 of SR 814.013 will be met by providing the necessary documents and annual reports relative 
to the disposal of the batteries to the Swiss Authorities.

Trademark Notices 

AMX®, AutoPatch®, and NetLinx® are trademarks of AMX.

Windows®, Windows 2000®, Windows NT®, and Windows XP Professional® are registered trademarks 
of Microsoft Corporation. 

HyperTerminal® is a copyright product of Hilgraeve Inc. 

3M®, Desco®, Richmond Technology®, and Plastic Systems® are registered trademarks. 

Neuron® and LonTalk® are registered trademarks of Echelon.

TosLink® is a registered trademark of the Toshiba Corporation.

Ethernet® is a registered trademark of the Xerox Corporation.

Other products mentioned herein may be the trademarks of their respective owners.
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Notices
Warnings & Cautions

This manual uses the following conventions and icons to draw attention to actions or conditions that 
could potentially cause problems with equipment or lead to personal risk.

ESD Warning: The icon to the left indicates text regarding potential danger associated with the 
discharge of static electricity from an outside source (such as human hands) into an integrated 
circuit, often resulting in damage to the circuit.

Warning: The icon to the left indicates text that warns readers against actions or conditions that 
could cause potential injury to themselves.

Caution: The icon to the left indicates text that cautions readers against actions that could cause 
potential injury to the product or the possibility of serious inconvenience.
5Epica DG Instruction Manual
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Overview & General Specifications
Overview & General Specifications

The information in this manual applies to the following Epica DG enclosure model and 
Epica DG (Digital Generation) boards:

Applicability Notice
Epica DG Enclosure (16 RU)

Epica DG Input & Output Boards

Four types of Epica DG boards are currently available: DG MTP® Fiber, DG DVI, DG RGBHV/HD-15, 
and DG HD-SDI. Each board fills one slot and has 16 connections. For general board information, see 
page 11 and page 33; for specific board information, see the applicable board chapter in this manual. 

Product Notes
The Epica DG is available in a variety of input to output configuration sizes and can contain an 
assortment of I/O boards in a single enclosure.

Note: Because the Epica DG Distribution Matrix is available in various board configurations, the 
illustrations in this manual may differ from the model(s) you purchased.

An Epica DG enclosure fits in a broad range of digital and analog environments and is controllable from 
a variety of sources (see page 13).

Configuration & Enclosure Sales #

144x144 FG1055-10

Epica DG MTP® Fiber Boards & Sales #

Input FG1055-410

Output FG1055-413

Epica DG DVI Boards & Sales #

Input FG1055-416

Output FG1055-419

Epica DG RGBHV/HD-15 Boards & Sales #

Input FG1055-422

Output FG1055-425

Epica DG HD-SDI Boards & Sales #

Input FG1055-434

Output FG1055-437
7Epica DG Instruction Manual



Overview & General Specifications
Epica DG Features

z Limited Lifetime Warranty (see warranty at www.amx.com or on the AMX AutoPatch CD)
z Combines signal conversion with fiber optic routing and transmission
z 24-hour technical support
z Up to 144x144, in increments of up to 16
z System self-diagnostics (power monitoring, fan control and monitoring, signal and

temperature sensing)
z Ability to mix a variety of digital boards and an analog board in a single enclosure
z Virtual matrices (levels) / groupings
z Link to other AMX AutoPatch matrix switchers
z Global and local presets
z RS-232 and USB ports
z Configuration size upgrade potential
z Redundant (hot-swappable) power supplies (RPS)

Epica DG Control Features

Epica DG systems support the following protocols: BCS* (Basic Control Structure) and XNNet.

Several control options are available, and multiple control methods can be used on the same system.

z Compatible with a number of AMX control devices (for control programming information, 
see the instruction manual for the specific interface)

z APControl 3.0.1 software (free with all systems)
z APWeb (TCP/IP control via an external module)
z Supports AMX AutoPatch’s simple BCS serial control protocol
z Supports third-party controllers

* BCS is sent as ASCII characters through the RS-232 serial port.

Note: Features and specifications described in this document are subject to change without notice. 

Front View
The enclosure, which is the structural basis of the Epica DG Distribution Matrix, is custom built for each 
installation. The Epica DG enclosure is controlled using control software or an external controller 
(see page 13). The LEDs (FIG. 1) indicate status for power, redundant power supplies (RPS), and 
communication activity (see page 36).

FIG. 1  Front view of an Epica DG and front panel LEDs
8 Epica DG Instruction Manual



Overview & General Specifications
Rear View
The enclosure’s appearance, as viewed from the rear (FIG. 2), will vary depending on the number and 
types of I/O boards present (which is also the main determinate of the weight).  

Rear View Components

z Input and output boards (some slots may be empty, depending on the configuration)

z 3 expansion/control slots

z CPU/Control board

z Up to 4 power supplies with receptacles and the power specifications

z Serial number

Note: The Epica DG has two hand hold insets, one on each side.

FIG. 2  Rear view of an Epica DG enclosure

Power supplies 

Serial number

Input boards (up to 9)

CPU/Control board

Output boards (up to 9)

Hand hold inset

Expansion slots
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Overview & General Specifications
The following sections briefly introduce the hardware on the rear of the enclosure.

CPU/Control Board

The CPU/Control board (FIG. 3) is directly below the input connectors on the left rear of the enclosure.

Each CPU includes the following port options:

z Control (serial) port – for attaching an external control device (see page 27)

z Enc Link (RJ-45) port – primarily for linking to other types of enclosures (see page 20)

z USB (Mini-B) port – for attaching an external control device (see page 29)

Two LED indicators are located above and to the left of the first power supply unit:

z Communication Status Indicator – for Ethernet / linking communication activity

z System Status Indicator – for system status

Power Supply Units

Each power supply unit on the rear of the enclosure (FIG. 4) has a power receptacle that will accept all 
major international standard power sources. (US power cords are included with all shipments unless 
ordered otherwise.) Maximum power specifications are provided on the power supply receptacles. For 
information on applying power, see page 35.

The power supply unit has three LED indicators (listed left to right):

z AC ( ) is green: power is good

z DC ( ) is green: power is good

z Temperature ( ) is not illuminated: temperature is good (when amber, the temperature is 
above normal)

Caution: Each power supply has a small toggle switch to the left of its LEDs that controls internal 
power and must remain flipped to the right for the system to operate. Do not flip this switch to the left.

FIG. 3  CPU/Control hardware

FIG. 4  Power supply receptacle, LEDs, and switch

USB (Mini-B) port

Enc Link (Ethernet RJ-45 10/100) port

Control (serial DB-9) port

Communication Status indicator
System Status indicator

Indicator LEDs

Leave switch on (flipped right)
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Overview & General Specifications
Expansion/Control Slots

Each enclosure has three expansion/control slots (FIG. 2) for expansion boards to increase functionality 
and add new features to the system. If expansion boards are part of the original system, the boards are 
installed at the factory.

Input/Output Boards

A single enclosure can handle a combination of digital signals (such as, HD-SDI, MTP® Fiber, and 
DVI-D and analog signals (RGBHV) depending on the type of input/output boards.

Epica DG enclosures have 18 vertical board slots (9 slots each for input and output boards with up to 16 
channels per board), allowing for a maximum configuration of 144x144.

For information on the boards included in your system, including connector types, cabling directions, 
and specifications, see the specific board chapter in this manual. For information on adding or replacing 
boards, see “Appendix E – Board Replacement” on page 95.

Input & Output Connectors

Input and output connectors are the attachment points for source and destination devices that connect to 
the system. Viewed from the rear of the enclosure, the input boards (for attaching sources) are on the left, 
and the output boards (for attaching destinations) are on the right.

Input and output channels (that correspond to the connectors) are numbered separately and read from top 
to bottom. The numbers for the channels are located on the metal to the left of each connector.

Serial Number

The serial number is normally located on the rear of the enclosure on the left (see FIG. 2 on page 9). 
Before installation, we recommend recording the serial number for each enclosure in the system in an 
easily accessible location.

FIG. 5  DG DVI, DG HD-SDI, DG MTP® Fiber, and DG RGBHV/HD-15 input boards

DG DVI board

DG MTP® Fiber board

DG RGBHV/HD-15 board

DG HD-SDI board
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Overview & General Specifications
General Specifications

For individual board information and specifications, see the specific board chapter in this manual.

Note: Features and specifications described in this document are subject to change without notice.

Configuration & Control
The configuration file contains routing and control information for an AMX AutoPatch Routing System. 
Each system is programmed (configured) at the factory according to customer specifications.

Configuration Information

The custom configuration file is provided on the AMX AutoPatch CD that is shipped with each system. 
The software provided on the CD can be used to further customize the configuration file (see page 67).

Unless you need to modify your system, you will not need to use any of the configuration software that is 
included on the CD. We recommend always make a copy of the configuration file before modifying it.

Configuration file modifications include creating local presets, customizing input and output channel 
names for control display (e.g., in APWeb’s control interface), as well as adding or managing hardware. 
Configuration file modifications are made with XNConnect, which graphically displays the AMX 
AutoPatch system and its control configuration. Other configuration software for specific hardware or for 
adjusting signal quality is also available on the AMX AutoPatch CD. For details, see the individual 
program’s Help file.

Specifications

Parameter Value

Approvals UL

AC Power per Supply 100 to 240 VAC single phase (50 Hz to 60 Hz)

Power Consumption (max.) 1563 Watts

Power Consumption (typical) 850 Watts, fully loaded enclosure

Thermal Dissipation (max.) 5333 BTU/hr.

Thermal Dissipation (typical) 2900 BTU/hr., fully loaded enclosure

Operational Temperature (peak) 32° F to 110° F (0°C to 43° C)

Humidity 0 to 90% non-condensing

Dimensions 21.1 in. (53.6 cm) depth
19.0 in. (48.26 cm) width with mounting ears
17.6 in. (44.7 cm) width without mounting ears
28 in. (71.1 cm) height (16 RU)

Weight Approximately 160 lb. (72.6 kg) per fully loaded enclosure

Shipping Weight Approximately 205 lb. (93 kg) per fully loaded enclosure
12 Epica DG Instruction Manual



Overview & General Specifications
Control Options

Epica DG enclosures can be controlled externally using one of the following options.

AMX Control Devices

The Epica DG is compatible with a number of AMX control devices (for control programming 
information, see the instruction manual for the specific interface).

Control Software 

Epica DG enclosures can be controlled using AMX AutoPatch software:

z APControl 3.0.1 – for control and scheduling

z Serial port located on the CPU
z Runs on a PC connected to the serial port
z Download from the AMX AutoPatch CD or from www.amx.com

z APWeb Server (TCP/IP) – for control, diagnostics, and third-party access

z Serial port located on the CPU
z Additional equipment is required
z Accessed through a TCP/IP interface, such as, a web browser (e.g., Internet Explorer)
z Contact AMX regarding limitations and conditions for operating an Epica DG on a 

company LAN (Local Area Network)

Control Panel

If the Epica DG is linked to an Optima, Optima SD, Modula, or Modula CatPro that has a CP-10 or 
a CP-20A Control Panel (local or remote), the panel can fully control the Epica DG. When other types 
of AMX AutoPatch Control Panels (whether front panels or remote panels) are used to control the 
Epica DG, some limitations apply. For specific control panel information, contact your AMX 
representative. For control panel operation, see the applicable product’s instruction manual.

BCS Serial Control Protocol

The Epica DG can be controlled with an external serial controller that sends and receives ASCII 
characters via an RS-232 serial port. AMX AutoPatch has developed a command language, BCS (Basic 
Control Structure) protocol, for programming control operations and for diagnostic purposes. BCS 
commands can be entered into a terminal emulation program (such as, HyperTerminal) running on a PC. 
For information on BCS commands, see the BCS Protocol Instruction Manual on the AMX AutoPatch CD 
or at www.amx.com.

Third-Party Controllers

A third-party controller can also be attached to an Epica DG enclosure. If using a third-party controller, 
see the controller documentation for operating instructions.
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Installation & Setup
Installation & Setup

UL Site Requirements
Warning: Per UL requirements – “This product must be installed within a restricted access location 
where access is through the use of a tool, lock and key, or other means of security, and is controlled 
by the authority responsible for the location. This product must be installed and maintained only by 
qualified technicians.”

These precautions are required due to accessible hazardous energy levels from the power supplies 
(greater than 240 W of available power). The energy levels are considered accessible because the input 
and output boards are removable by hand.

Site Recommendations
When placing the enclosure, follow the recommendations and precautions in this section to reduce 
potential installation and operation hazards.

Environment

z Choose a clean, dust free, (preferably) air-conditioned location.
z Avoid areas with direct sunlight, heat sources, or high levels of EMI (Electromagnetic 

Interference).

Chassis Accessibility

Make sure the front and rear panels of the enclosure are accessible, so that you can monitor the LED 
indicators. Leaving adequate clearance at the rear will also allow for easier cabling and service.

Power

Important: For proper functionality, apply power simultaneously to at least two power supplies on 
the Epica DG before applying power to the system’s source and destination devices. We 
recommend attaching all power cords to a surge protector (20 A) and/or an AC line conditioner.

The source’s electrical outlet should be installed near the router, easily accessible, and properly 
grounded. Power should come from a building branch circuit. We strongly recommend using a dedicated 
line for the system’s power. Use a minimum breaker current rating of 20 A for 110 V. 

To avoid an overload, note the power consumption rating of all the equipment connected to the circuit 
breaker before applying power.

General Hazard Precautions
These recommendations address potential hazards that are common to all installations:

Elevated Operating Temperature

The maximum rated ambient temperature for Epica DG enclosures is 110° F (43° C).

All equipment should be installed in an environment compatible with the manufacturer’s maximum 
rated ambient temperature. In a closed or multi-unit rack assembly, the operating ambient temperature of 
the rack environment may be greater than the ambient room temperature.

Caution: To protect the equipment from overheating, do not operate in an area that exceeds 
110° F (43° C) and follow the clearance recommendation below for adequate airflow.

Airflow Restriction

Epica DG enclosures are designed to adequately dissipate the heat they produce under normal operating 
conditions; however, this design is defeated when high heat producing equipment is placed directly 
above or below an enclosure. 
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Installation & Setup
Caution: To prevent overheating, avoid placing high heat producing equipment directly above or 
below the enclosure. The system requires a minimum of one empty rack unit above and below 
(three empty rack units are recommended). Verify that the openings on the top and sides of the 
enclosure are not blocked and do not have restricted air flow.

Mechanical (Rack) Loading

When installing equipment in a rack, distribute the weight to avoid uneven mechanical loading. Note 
that the Epica DG weighs approximately 160 pounds (72.6 kg) fully loaded.

Circuit Overloading

When connecting the equipment to the supply circuits, be aware of the effect that overloading the 
circuits might have on over-current protection and supply wiring.

Reliable Earthing (Grounding)

Reliable earthing of rack-mounted equipment should be maintained. If not using a direct connection to 
the branch circuit (e.g., plugging into a power strip), pay particular attention to supply connections.

Caution: For proper start up, AC power must be applied to at least two of the enclosure’s power 
supply units at the same time. We strongly recommend attaching all of the power cords to a single 
surge protector and/or an AC line conditioner. After powering up the enclosure, apply power to the 
source and destination devices.

Unpacking
The Epica DG is shipped with one enclosure per shipping box. The invoice is sent separately; a packing 
slip is attached to the outside of each box. Each box contains the following items:

T Enclosure on pallet
T Up to 4 power cords

T Other enclosure products, as needed

The documentation in the first box includes:

T AMX AutoPatch Epica DG Quick Start Guide

T AMX AutoPatch CD 

T AutoPatch Connector Guide

For orders comprising multiple enclosures, the shipping boxes are marked as “Chassis __ of __,” where 
the first blank is the box number and the second blank is the total number of boxes in the shipment.

Unpacking Tips

T  Before fully unpacking the enclosure(s), inspect the shipping box(es) for any signs of damage. 
If a box is partially crushed or any sides have been broken open, notify the shipping agency 
immediately and contact your AMX representative (see the warranty on the 
AMX AutoPatch CD or at www.amx.com).

T  Once unpacking is complete, closely check the physical condition of the enclosure. 

T  Keep the enclosure on the pallet for easy maneuverability with a pallet jack or fork lift until 
the enclosure is installed.

T  Collect all documentation.

Note: Please save the original shipping container and packing materials. AMX is not responsible for 
damage caused by insufficient packing during return shipment to the factory. Shipping boxes are 
available; contact your AMX representative for details.
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Rack Installation & System Setup
The Epica DG Distribution Matrix enclosure is mounted in a standard EIA 19 in. (48.26 cm) rack. 
Placing an Epica DG in a rack requires a minimum of three people.

Important: The system requires at least one empty rack unit above and below the enclosure to 
allow adequate airflow; three empty rack units are recommended.

Required items for rack installation:

T   Enclosure(s)

T   Standard EIA 19 in. (48.26 cm) rack
T Pallet jack or forklift
T   Screwdriver

T   Screws that fit your rack for mounting the enclosure(s)

T Power cords

T Surge-protector(s) – highly recommended

T  A PC or laptop computer with a null modem cable (for communication with the Epica DG via 
the RS-232 serial port)

Installation Procedure

The following is a list of installation recommendations:

z Write the serial number (normally located on rear of enclosure) in an easily accessible location 
before installing the Epica DG in a rack.

z Use an earth-grounded power cord / system with the Epica DG.

z Attach all power cords to a single surge protector and/or an AC line conditioner.

z Apply power to the Epica DG enclosure(s) before applying power to its source 
and destination devices.

Caution: To prevent overheating and airflow restriction, avoid placing high heat producing 
equipment directly above or below the enclosure. The system requires a minimum of one empty rack 
unit above and below (three empty rack units are recommended). Verify that the openings on the top 
and sides of the enclosure are not blocked and do not have restricted air flow.
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To install and setup an Epica DG:

Warning: This product must be installed within a restricted access location where access is through 
the use of a tool, lock and key, or other means of security, and is controlled by the authority 
responsible for the location. This product must be installed and maintained only by qualified 
technicians (see page 15). 

1. Install the Epica DG enclosure in a rack (see page 19).

2. If applicable – For multiple-enclosure systems, link them according to the instructions provided 
(see page 20).

Caution: On systems with MTP® Fiber boards, we recommend using the provided cable 
management bars or some other type of cable management system to avoid damage to the fiber 
cables.

3. If applicable – For systems with MTP® Fiber boards, install cable management bars (see page 19).

4. Following the “AutoPatch Connector Guide” (shipped with each system), attach only the first two 
source and destination devices (see “Attaching Inputs & Outputs” on page 33).

5. Attach the external control device (see “Attaching External Controllers” on page 26).

6. If applicable – For systems that require signal conversion modules, install them for the first two 
source and/or destination devices (see the module’s documentation).

7. Attach power cords to all power receptacles in each enclosure, then turn on the entire system 
(see “Applying Power & Startup” on page 35).
We recommend using a surge protector and/or an AC line conditioner.

8. Execute a test switch to ensure the system is working properly (“Executing a Test Switch” on 
page 38).

9. When the test switch works correctly, attach the remaining source and destination devices (refer to 
the “AutoPatch Connector Guide”) and any applicable conversion modules.

10. If applicable – use the EDID Programmer* and the board configuration software.**

* EDID Programmer software is used for programming the input boards if necessary 
(see “Appendix A – EDID Programmer” on page 61). 

** Board configuration software is used to adjust the source signal for optimal display (see page 52). 
For information on the DG HD-15 Wizard, see the “Epica DG RGBHV/HD-15 Boards” chapter on 
page 49. For information on other types of board configuration wizards, see the specific signal 
conversion module’s documentation.

Both software programs are on the AMX AutoPatch CD (also available at www.amx.com).

Additional Setup
Additional setup tasks may include creating the following:

z Local Presets and/or Custom Channel Names – See “Appendix B – Managing Configuration 
Files” on page 67.

z Global Presets – See the BCS Protocol Instruction Manual on the AMX AutoPatch CD or at 
www.amx.com.

FIG. 6  Installation procedure

Install 
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Rack Installation

Caution: To prevent overheating and airflow restriction, avoid placing high heat producing 
equipment directly above or below the enclosure. The system requires a minimum of one empty rack 
unit above and below (three empty rack units are recommended). Verify that the openings on the top 
and sides of the enclosure are not blocked and do not have restricted air flow.

The Epica DG has a hand-hold inset on each side. Do not attempt to lift the enclosure from the pallet to 
the rack by yourself.

Important: Do not use the board extractor handles to lift the enclosure or to maneuver it into place. 
Use a pallet jack to lift it, and use the hand-hold insets on the sides of the enclosure to maneuver it.

To install an enclosure in a rack (requires a minimum of 3 people):

1. While the enclosure is still on the pallet, cut loose and remove the outer straps.

2. Remove the tray (contains cables, etc.) from the top of the cardboard sleeve.

3. Remove the cardboard sleeve.

4. Cut loose and remove the inner straps. Carefully remove the shrink-wrap and corner cushions.

5. Use a pallet jack to move the enclosure into position.

6. Select a position in the rack that is accessible and does not restrict airflow (see page 15).

7. Lift and push the enclosure into the rack. Screw in the top 3 rack ear screws on each side.

8. Move the pallet jack out of the way. Supporting the enclosure as needed, screw in the remaining 
rack ear screws.

Attaching Cable Management Bars

Cable management bars are provided for Epica DG MTP® Fiber boards.

Caution: Do not severely bend or kink the MTP® fiber cable. Irreversible damage can occur. Refer 
to the physical limitations (bend radius) specified for the cable by the manufacturer.

To install cable management bars:

1. Align the two screw holes on the end of the cable management bar with the two screw holes at the 
top of the board as shown at left in FIG. 7. (Note that the long part of the bar is left of the holes.)

2. Insert and tighten the two screws at the top of the cable management bar.

3. Insert and tighten the two screws at the bottom of the cable management bar.

FIG. 7  Install cable management bars
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Linking Enclosures
Epica DG enclosures are linked using Ethernet (RJ-45 10/Base-T) ports. Linking from an Epica DG 
enclosure to another Epica DG enclosure is currently not supported; however, the Epica DG can link to 
other types of AMX AutoPatch Distribution Matrices.

Linking enclosures allows control information to pass between them. In a multiple-enclosure system, the 
enclosure with a control panel or with an external controller attached receives control information and 
passes on relevant information to the other enclosures via the links, as well as retrieving control request 
for success/failure from each of them.

Caution: AMX AutoPatch systems should only be linked in their own isolated networks.

If any of the linked enclosures were not part of the original system, contact technical support
(see page 40) for important information not included here.

Important: Enclosures must be cabled correctly after linking. To ensure that you are attaching the 
correct signal cables to the correct enclosure, check the “AutoPatch Connector Guide” that shipped 
with the system, as well as the system / enclosure numbers on the rear of each enclosure.

Enclosures & Ethernet Connectors

The method used for linking depends on the type of Ethernet connector on each enclosure’s CPU. 
The table below indicates the type of Ethernet connectors available on AMX AutoPatch enclosures.

* The RJ-45 port is labeled “Link” on some enclosures and “ENC LINK” on others.

Link Cables & Equipment

AMX provides link cables and equipment for enclosures that are ordered as part of a linked system. 
Linking from one Epica DG enclosure to another Epica DG enclosure is currently not supported, but the 
Epica DG can link to other AMX AutoPatch Distribution Matrices using the cable and equipment 
specified in the table below. A Multi-Port (8 or 5) Switch is also provided for some types of 
multiple-enclosure systems.

Enclosure Ethernet 10Base-T* (RJ-45) Ethernet 10Base-2 (BNC)

Epica DG

Epica-128 & Epica-256

Modula & Modula CatPro

Optima & Optima SD

Precis SD

Link Cable & Equipment for Epica DG Linked Systems

Enclosure −> Cable −> Converter −> Cable −> Enclosure

Epica DG RJ-45 straight-through patch Media Converter RG-58 coax Epica-128 or Epica-256

Epica DG RJ-45 straight-through patch Media Converter RG-58 coax Modula & Modula CatPro

Epica DG RJ-45 crossover – – Optima & Optima SD

Epica DG RJ-45 crossover – – Precis SD

Epica DG -------------- Linking currently not supported -------------- Epica DG
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Link Cables & Equipment List

z RJ-45 Crossover Cable: use to connect 10Base-T enclosures to a Media Converter or 
to a Multi-Port Switch (also used for direct linking between 10Base-T enclosures). 
The cable is wired to TIA/EIA-568-A on one end and TIA/EIA-568-B on the other end.

z RJ-45 Straight-Through Patch Cable: use to connect a 10Base-T enclosure to 
a Media Converter or to a Multi-Port Switch. Both ends of the cable are wired to 
TIA/EIA-568-A.

z RG-58 Coax Cable: use to connect a 10Base-2 (BNC) enclosure to a Media Converter (also 
used to daisy chain 10Base-2 enclosures).

z Media Converter: use when linking 10Base-T (RJ-45) enclosures to 10Base-2 (BNC) 
enclosures.

z Multi-Port Switch: use when linking some types of multiple-enclosure systems.

Ethernet Connector LEDs

The Link, 10Base-T Ethernet (RJ-45), connector on the Epica DG has two LEDs that indicate 
communication status when the enclosure is linked to an active system.

The LEDs indicate the following:

z Green LED on – speed status is 100 Mbps

z Green LED off – speed status is 10 Mbps

z Amber LED on – link status is active

Note: The Comm (Communication Status) indicator at the top left of the CPU indicates if Ethernet 
traffic is on the system by blinking green.

FIG. 8  Ethernet connector LEDs

Green LED – Speed Status

Amber LED – Link Status
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Linking between Epica DG and Optima, Optima SD, or Precis SD

An Epica DG can be directly linked to an Optima, Optima SD, or Precis SD enclosure via their Ethernet 
10Base-T (Link) ports using an RJ-45 crossover cable.

Cable Length Requirements

To link an Epica DG to an enclosure with a 10Base-T Ethernet port:

1. Insert the connector on one end of the RJ-45 crossover cable into the Epica DG enclosure’s 
Enc Link / RJ-45 port.

2. Insert the connector on the other end of the crossover cable into the Ethernet 10Base-T / RJ-45 port 
on the second enclosure’s CPU.

When power is applied, the Ethernet connector LEDs illuminate indicating communication status
(see page 21).

Network Segment Cable Type Maximum Distance

Epica DG to Optima, Optima SD or Precis SD RJ-45 crossover 100 ft. (30.5 m)

FIG. 9  An Epica DG linked to an Optima using RJ-45 crossover cable

System & Enclosure Numbers

RJ-45 Crossover Cable
Max. 100 ft. (30.5 m)
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Linking Epica DG to Modula, Modula CatPro, Epica-128, or Epica-256

An Epica DG enclosure can be linked to an enclosure with an Ethernet 10Base-2 connector (Modula, 
Modula CatPro, Epica-128, or Epica-256) by using a Media Converter. Additional Ethernet 10Base-2 
enclosures can be daisy-chained off the first one.

Cable Length Requirements

Important: Attach 50-ohm termination connectors to the open ends of the T-connectors on the 
Media Converter and on the last enclosure of the cable run.

To link an Epica DG to an enclosure with a 10Base-2 Ethernet port:

1. Insert the RJ-45 straight-through patch cable into the Epica DG enclosure’s Enc Link / RJ-45 port.

2. Insert other end of the cable into the Media Converter’s 10/100 / RJ-45 port.

3. Fasten a T-connector to the Media Converter’s BNC connector.

4. Attach an RG-58 coax cable to the T-connector.

5. Add a 50-ohm termination connector to the other end of the T-connector.

6. Fasten a T-connector to the Ethernet 10Base-2 / BNC connector on the second enclosure’s CPU.

7. Attach the other end of the RG-58 coax cable to the T-connector.

8. If applicable – Attach additional enclosures with T-connectors and RG-58 coax cables.

9. Add a 50-ohm termination connector to the open end of the T-connector on the last enclosure of the 
cable run.

When power is applied, the Ethernet connector LEDs illuminate (see page 21).

Network Segment Cable Type Maximum Distance

Epica DG to Media Converter RJ-45 straight-through patch 100 ft. (30.5 m)

Media Converter to last enclosure in daisy chain RG-58 coax 10 ft. (3.05 m) total

FIG. 10  An Epica DG linked to a Modula using a Media Converter

The total length of all cables between 
the Media Converter and the last 
enclosure in a daisy chain cannot 
exceed 10 ft. (3.05 m).

RG-58 Coax Cable
Max. 10 ft. (3.05 m)

50-ohm Termination Connector

Straight-Through Patch Cable
Max. 100 ft. (30.5 m)

Media Converter
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Linking More Than Two Enclosures

Linking an Epica DG enclosure to multiple other types of enclosures* (other than linking in a daisy 
chain off an enclosure with a 10Base-2 / BNC connector) requires a Multi-Port Switch and RJ-45 
straight-through patch cables. Depending on the other types of enclosures, a Media converter(s) and 
RG-58 coax cable(s) may also be required. FIG. 11 shows an Epica DG enclosure linked to an Optima 
and to a Modula using a 5-Port Switch and a Media Converter.

* Applies when linking to Modula, Modula CatPro, Epica-128, or Epica-256 enclosures.

Cable Length Requirements

Note: If you have questions regarding cabling or network related issues in conjunction with using a 
Multi-Port Switch (or hub) for linking enclosures, contact your network administrator.

When attaching multiple enclosures to a Multi-Port Switch, one or more can be connected directly to 
the Multi-Port Switch (see steps below) and/or one or more can use a Media Converter to connect to 
the Multi-Port Switch (see steps on page 25). In a system with multiple 10Base-2 enclosures, only one 
needs to be attached to the Multi-Port Switch with a Media Converter. The rest can be daisy-chained.

To link an Epica DG enclosure to a Multi-Port Switch:

1. Insert one end of the RJ-45 straight-through patch cable into the Enc Link (RJ-45) Ethernet port on 
the Epica DG enclosure.

2. Insert the other end of the RJ-45 straight-through patch cable into the Multi-Port Switch.

3. Repeat Steps 1 and 2 for enclosures with 10Base-T ports.* Go to page 25 for 10Base-2 ports.

* Applies when linking an Optima, Optima SD, or Precis SD to a Multi-Port Switch.

Network Segment Cable Type Maximum Distance

Epica DG to Multi-Port Switch RJ-45 straight-through patch 100 ft. (30.5 m)

Multi-Port Switch directly to another type enclosure RJ-45 straight-through patch 100 ft. (30.5 m)

Multi-Port Switch to Media Converter RJ-45 straight-through patch 100 ft. (30.5 m)

Media Converter to last enclosure in daisy chain RG-58 coax 10 ft. (3.05 m) total

FIG. 11  An Epica DG enclosure linked to an Optima and a Modula

The total length of all cables between the 
Media Converter and the last enclosure in a 
daisy chain cannot exceed 10 ft. (3.05 m).

Straight-Through Patch Cable
Max. 100 ft. (30.5 m)

RG-58 Coax Cable
Max. 10 ft. (3.05 m)

Media Converter

5-Port Switch

50-ohm 

Link Epica DG

Link Modula

(See steps above)

(See steps

Link Optima
(See steps above)

Termination
Connectors

on next page)
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Important: Attach 50-ohm termination connectors to the open ends of the T-connectors on the 
Media Converter and on the last enclosure on the cable run.

To link enclosures* with 10Base-2 Ethernet connector to Multi-Port Switch:

1. Fasten a T-connector to the Ethernet BNC connector on the enclosure’s CPU.

2. Attach an RG-58 coax cable to the T-connector.

3. If applicable – Attach additional enclosures with T-connectors and RG-58 coax cables.**

4. Add a 50-ohm termination connector to the open end of the T-connector on the last enclosure of the 
cable run.

5. Fasten a T-connector to the Media Converter’s BNC connector.

6. Attach the other end of the RG-58 coax cable to the T-connector on the Media Converter. 

7. Add a 50-ohm termination connector to the open end of the T-connector on the Media Converter.

8. Insert one end of the RJ-45 straight-through patch cable into the 10/100 (RJ-45) Ethernet port on the 
Media Converter.

9. Insert the other end of the RJ-45 straight-through patch cable into the Multi-Port Switch.

When power is applied to the enclosures, the Ethernet connector LEDs illuminate indicating 
communication status (see page 21).

* Applies to Modula, Modula CatPro, Epica-128, and Epica-256 enclosures.

** The total length of all RG-58 coax cables between the Media Converter and the last enclosure in the 
daisy chain cannot exceed 10 ft. (3.05 m).
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Attaching External Controllers
The Epica DG can be controlled externally by attaching a control device that uses one of the 
communication protocols listed below:

z BCS (Serial) – ASCII sent over a null modem serial cable via the serial port

z BCS (USB) – ASCII sent over a USB cable via the USB (Mini-B) port

z XNNet – AMX AutoPatch protocol via the serial port

Important: The Ethernet connector is not a TCP/IP interface and is used primarily for linking 
enclosures (see page 20).

Control Options

The communication protocols listed above are used for these control options:

AMX Control Devices

The Epica DG is compatible with a number of AMX control devices (for control programming 
information, see the instruction manual for the specific interface).

APControl 3.0.1

APControl 3.0.1 software (for control and scheduling) runs on a PC connected to an Epica DG via 
the serial port (DB-9) or the USB (Mini-B) port and is available on the AMX AutoPatch CD. 
APControl 3.0.1 has a setup wizard that discovers the system’s configuration information.

APWeb (TCP/IP)

The APWeb Server (for control, diagnostics, and third-party access) is accessed through a TCP/IP 
interface, such as, a web browser (e.g., Internet Explorer). The Epica DG serial port (DB-9) is used to 
access APWeb. Additional equipment is required for APWeb. For setup and operation information, see 
the APWeb Server Module’s documentation on the AMX AutoPatch CD and at www.amx.com.

Important: Contact AMX regarding limitations and conditions for operating an Epica DG on a 
company LAN.

XNNet Protocol (Serial)

Advanced programmers who want to design their own control programs can use AMX AutoPatch 
XNNet protocol. The AMX Autopatch CD includes the XNNet Communication Library, an interface 
library that supports C, Java, and Visual Basic with examples of the XNNet protocol in use.

BCS (Serial) Control

AMX AutoPatch has developed a command language, BCS (Basic Control Structure), for executing 
control operations and for diagnostic purposes. BCS commands are issued via a terminal emulation 
program, such as, HyperTerminal. For information on BCS commands, see the BCS Protocol Instruction 
Manual on the AMX AutoPatch CD or at www.amx.com.

Third-Party Controllers (Serial)

Third-party controllers connect to the serial port (DB-9) or USB (Mini-B) port on the CPU. If using a 
third-party controller, see the controller documentation for setup and operating instructions.
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Connecting Serial Controllers

An external serial controller is any device that can send and receive ASCII code over an RS-232 
(null modem) or RS-422 serial cable attached to the serial port (DB-9) on the enclosure’s CPU. PCs are 
common serial controllers. Once a PC is attached to the Epica DG, the system can be controlled by 
running APControl 3.0.1 software on the attached PC (see the AMX AutoPatch CD). The system can also 
be controlled by entering BCS commands into a terminal emulation program (e.g., HyperTerminal). For 
USB serial control information, see page 29.

PC Requirements for APControl 3.0.1

T  Windows XP Professional® or Windows 2000® 

T  Java Runtime Environment (JRE):  v1.4.2 or the latest version

T  Minimum Hardware:  166 MHz, 128 MB RAM, 20 MB free disk space, 800x600 display

T  Recommended Hardware:  2.0 GHz, 512 MB RAM, 20 MB free disk space, 
1280x1024 display

T  Serial port or USB port

PC Requirements for BCS

T  Windows XP Professional® or Windows 2000® 

T Terminal emulation program

T  Serial port or USB port

Connecting Serial Controllers to DB-9 Control Port

The RS-232 cable pinout is in FIG. 13 on page 28, and the RS-422 cable pinout is in FIG. 14 on page 29.

To establish external serial control:

1. RS-232 serial cable (null modem) – Plug one end of the null modem serial cable into the Control 
port (serial DB-9) on the enclosure (FIG. 12).
Or
RS-422 serial cable (requires reconfiguring the Control serial port) – Establish a serial connection 
with a PC using the USB port (see page 32). Install and open XNConnect. Select File > Discover 
System. In the Hardware view, right-click the serial port icon and select Change Settings. On the 
Modify Serial Port drop-down menu select: Mode > RS-422 Character (unless directed by technical 
support to use RS-422 Block). Click Download; click OK. From the Configure menu, select Reboot 
All Devices. Plug the RS-422 serial cable into the Control port (serial) on the enclosure (FIG. 12).*

* After a serial port is configured for RS-422 cable, do not attach an RS-232 cable without first 
reconfiguring the port in XNConnect.

FIG. 12  Connect to serial port

Control (serial) port

Cable to serial control device / system
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2. Plug the other end of the serial cable (RS-422 uses platform specific pinout) into the serial port on 
the serial controller.

3. If not already on, apply power first to the Epica DG enclosure and then to the source and destination 
devices (see “Applying Power & Startup” on page 35).

Caution: To avoid system damage, follow the power-up sequence on page 35. We recommend 
attaching all power cords to a surge protector and/or AC line conditioner.

4. Setup and run the desired method of control:
AMX control devices – for control programming information, see the instruction manual for the 
specific interface
APControl 3.0.1 – Install and open the latest version of the program (located on the 
AMX AutoPatch CD). Follow the setup wizard, which will discover the system’s configuration 
information and open the APControl Launchbar.
Terminal emulation (HyperTerminal) – Open the program, 
select the COM port, and set the settings to match the default ones
in the Epica DG Serial Port Settings table to the right. Click OK. 
A short splash screen appears.

5. Execute a test switch to ensure the Epica DG is working properly
(see “Executing a Test Switch” on page 38).

Serial Communication Settings

When controlling the system with a serial controller, use serial communication software and make sure 
the baud rate is set correctly for the system. The recommended (default) settings for serial 
communication with an Epica DG Distribution Matrix are provided in the table above. Epica DG 

enclosures support baud rates of 9600 (default), 19200, 38400, and 57600. The settings on the PC serial 
communication software and the enclosure must correspond to each other. If a change is required to 
make them match, changing the PC’s settings is preferable. If you decide to change the enclosure’s 
settings instead, use XNConnect (see the Help file).

RS-232 Pin Diagram

Use a null modem cable that matches the pin diagram in FIG. 13 for RS-232 without hardware flow 
control. AMX AutoPatch equipment requires pins 2, 3, and 5 only. 

RS-232 Pin Diagram

FIG. 13  RS-232 null modem cable pin diagram, no hardware flow control

Epica DG 
Serial Port Settings

Baud Rate 9600

Data Bits 8

Parity None

Stop Bits 1

Flow Control None
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RS-422 Pin Diagram

Use a cable that matches the pin diagrams in FIG. 14 for RS-422, and change the settings in the 
configuration file per Step 1 on page 27.

RS-422 Pin Diagram

Connecting Serial Controllers to USB Port

Controlling the Epica DG using a USB connection requires the creation of a virtual COM port. Once 
created, the virtual COM port is used as if it were a standard serial connection and can connect to a 
control application (such as, APControl 3.0.1) or to a terminal emulation program (such as, Windows 
HyperTerminal) for BCS control.

Important: You must have adequate rights to install USB device drivers to the PC. Check with your 
System Administrator to be sure you have the required access.

To attach a PC to the USB (Mini-B) port:

1. Apply power to the Epica DG (see page 35).

2. Connect the Epica DG to a PC running Windows using a USB cable (FIG. 15).

If establishing a new connection, complete Steps 3, 4, and 5.
Or
If reconnecting after previously establishing a USB connection, go to Step 4 on page 32 to run the 
control program.

FIG. 14  RS-422 cable pin diagram

FIG. 15  Connect to USB port

Cable to PC

USB (Mini-B) port
29Epica DG Instruction Manual



Installation & Setup
Note: The following dialog boxes appear only during the initial USB connection. Once the virtual 
COM port has been assigned to the Epica DG, the dialog boxes do not appear again. If they do 
appear, you have connected the USB plug to a different COM port than the initial one.

The Found New Hardware notice window appears briefly. The Hardware Wizard will refer to the  
virtual COM port used by the Epica DG as an “AutoPatch USB Bridge”.

The Found New Hardware Wizard opens.

Note: The dialog boxes may differ slightly from those shown here, depending on the operating 
system.

3. In the Install Hardware Device Drivers dialog box, select Search for a suitable driver 
and click Next.
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4. In the Locate Driver Files dialog box,
Select CD-ROM drives to locate APBridge.inf on the AMX AutoPatch CD 
(Configuration\APConfig\USB) that shipped with your Epica DG. Click Next.
Or
Select Specify a location to find APBridge.inf in the folder that holds your AMX AutoPatch 
software. Click Next.

5. In the Browse for Folder box, navigate to and select the folder containing the APBridge.inf file. 
Click OK, then click Next.

6. Select Continue Anyway to install the software.

7. Click Finish when prompted to complete the installation.

You must identify the virtual COM port assigned to the USB connector to enable communication 
between the control PC and the Epica DG.
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To identify the virtual COM port:

1. Open the Windows Device Manager* (Start/Settings/Control Panel/System/System Properties/
Hardware tab/Device Manager button) and expand Ports by clicking on the “+”. 

2. Right-click the AutoPatch USB Bridge and select Properties.

3. In the AutoPatch USB Bridge Properties dialog box, select the General tab. Make note of the COM 
port assigned to the AutoPatch USB Bridge. This port number must be entered when setting a 
connection in a terminal emulation program. The PC will always associate a specific USB 
connector with the assigned virtual COM port. The PC will not recognize the Epica DG if you 
disconnect and reconnect using a different COM port.

4. Set up and run the desired method of control:
AMX control devices – for control programming information, see the instruction manual for the 
specific interface.
APControl 3.0.1 – Install and open the latest version of the program (located on the 
AMX AutoPatch CD). Follow the setup wizard, which will discover the system’s configuration 
information and open the Launchbar.
Or
Terminal emulation – Open the program. Check to be sure the Communications Port option is set 
for the port determined in Step 3 above. Set the settings to match the default ones in the Epica DG 
Serial Port Settings table above. Click OK. A short splash screen appears.

5. Execute a test switch to ensure the Epica DG is working properly (see “Executing a Test Switch”, 
page 38).

Note: If power is cycled, the USB connection must be reestablished. Remove the USB cable and 
close the software application in use. Then reconnect the USB cable to the same USB connector 
used previously and reopen the communication software. 

* The Device Manager may have a different location depending on the operating system and theme 
selected.

Epica DG Serial Port Settings

Baud Rate 9600

Data Bits 8

Parity None

Stop Bits 1

Flow Control None
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Attaching Inputs & Outputs
Input and output connectors are the attachment points for source and destination devices that connect to 
the system. Epica DG enclosures have 18 vertical board slots (9 slots each for the input and the output 
boards with up to 16 channels per board), allowing for a maximum configuration of 144x144. Viewed 
from the rear of the enclosure, the input boards (for attaching sources) are on the left, and the output 
boards (for attaching destinations) are on the right.

Connectors & I/O Channels

Some Epica DG board types, their connector types, and the number of 
available I/O channels per board are listed in the table below.

* DMS-59 connectors are numbered for two breakout I/O channels each.

** MTP®/MPO connectors are numbered for three I/O channels each.

Because some connectors are capable of routing multiple I/O channels, the 
I/O channels are numbered rather than the connectors. The I/O channel 
numbers are to the left of the connectors and read from top to bottom. 
Numbering is consecutive for inputs; outputs start over at 1 and follow the 
same pattern. Boards are allocated 16 I/O channels each. 

For board connector information and specifications, see the specific board chapter in this manual.

Board/Signal Type # & Type of Connectors # I/O Channels

DVI / DVI-D 8 DVI-I
4 DMS-59*

8
8

HD-SDI 16 BNC 16

Fiber & DVI / DVI-D 5 MTP®/MPO**
1 DVI-I

15 
1

RGBHV 16 HD-15 16

FIG. 16  Numbers indicate I/O channels
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Attaching Cables

Cable Management Bars (for MTP® Fiber Boards)

If AMX AutoPatch cable management bars are used, they are installed before attaching cables.

Caution: Do not severely bend or kink the MTP® fiber cable. Irreversible damage can occur. Refer 
to the physical limitations (bend radius) specified for the cable by the manufacturer.

Input and Output Signal Cables

When attaching input and output signal cables, refer to the sheet labeled “AutoPatch Connector Guide” 
that is shipped with each system. The guide shows you where to attach each signal cable on the rear of 
each enclosure. The system and enclosure numbers are on the rear of the Epica DG (if not on the rear, the 
numbers are on the side). Follow the guide exactly; the system was programmed at the factory to operate 
only as indicated on the “AutoPatch Connector Guide.” 

Note that some connectors (such as Fiber and DVI*) support multiple I/O channels (see FIG. 18). 

Before connecting all input and output cables, attach only the first two input and output cables (and any 
applicable signal conversion modules) and execute a test switch (see page 38). When the test switch is 
successful, attach the rest of the input and output cables. 

* The configuration file and the internal pathways define each DMS-59 connection as two discrete signal 
paths for routing.

For information on cabling specific types of connectors, see the specific board chapter in this manual.

FIG. 17  AMX AutoPatch Epica DG cable management bars

FIG. 18  Some connectors support multiple I/O channels

Fasten cable management bar
with two screws at top and two
at bottom

Tie cable to cable management 
bar far enough below connector
to allow for manufacturer’s
recommended bend radius

Fiber connectors (3 I/O channels each)

DMS-59 connectors (2 I/O channels each)

The DVI connectors on the DMS-59 breakout cable 
are labeled 1 (bottom connector) and 2 (top connector) 
and route signals that correspond to the numbering to 
the left of the DMS-59 receptacle on the enclosure:
• 1 for the number with the lower numerical value
• 2 for the number with the higher numerical value
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Applying Power & Startup
The enclosures’s universal power receptacles will accept all major international standard power sources. 
(US power cords are included with all shipments unless ordered otherwise.) Maximum power 
specifications are on the power receptacle (also listed on page 12). Always use an earth-grounded power 
cord / system with an Epica DG.

The source electrical outlet should be installed near the Epica DG, easily accessible, and properly 
grounded. Power should come from a building branch circuit. We strongly recommend using a dedicated 
line for the system’s power. Use a minimum breaker current rating of 20 A for 110 V. To avoid an 
overload, note the power consumption rating of all the equipment connected to the circuit breaker before 
applying power.

Important: For proper functionality, apply power simultaneously to at least two power supplies on 
the Epica DG before applying power to the system’s source and destination devices. We 
recommend attaching all power cords to a surge protector (20 A) and/or an AC line conditioner.

Power-Up Sequence

To apply power simultaneously to power supplies:

1. Attach the first two source and destination devices. 
Do not apply power to the source and destination devices until Step 7. 

2. Plug a power cord into each power receptacle on the enclosure.

3. Plug the other end of each power cord into a power strip that is turned off (we recommend using a  
20 A power strip on a 110 circuit).

4. Turn on the power strip. Check the Indicator LEDs on the front and rear of the enclosure. the 
indicator LEDs may take some time before they illuminate while the system runs its self-diagnosis.

5. Attach the external control device/system (see page 27).

6. Apply power to the external control device/system. 

7. Apply power to the source and destination devices. 
The system is ready for a test switch (see page 38).

For startup information on specific types of control, see page 36 before executing a test switch.

Caution: Each power supply has a small toggle switch to the left of its LEDs that controls internal 
power and must remain flipped to the right for the system to operate. Do not flip this switch to the left.

FIG. 19  Attach power cables to each power receptacle
35Epica DG Instruction Manual



Installation & Setup
Indicator LEDs

When the enclosure powers up, the indicator LEDs will respond as follows:

Important: If the indicator LEDs do not respond with a normal display as stated above, contact 
technical support (see page 40).

Powering Down

Important: When the system is powered down, be sure the indicator LEDs on the CPU are off and 
the fans have stopped before reapplying power.

The system is ready to disconnect the factory default switch and to execute a test switch (see page 38) 
using the control method of your choice. 

Serial Control Device Startup

If you have not already done so, attach the serial control device to the enclosure (see page 26) and open 
the control program.

AMX Control Devices

The Epica DG is compatible with a number of AMX control devices (for control programming 
information, see the instruction manual for the specific interface)

APControl 3.0.1

If you are using APControl 3.0.1, install and open the latest version of the program. Follow the 
directions in the setup wizard. As part of the setup wizard, APControl 3.0.1 will discover the system’s 
configuration information. From the Launchbar menu, select Views / CrossBar and click on the 
crosspoints to execute switches.

Epica DG LED Indicators

Indicator Normal Display Cautionary Display

Front Panel

POWER
(power status) Green

RPS (redundant 
power supplies) Green

Blinking green:  no redundancy
Blinking Red:  80 to 100% power load
Red:  system will not enable DC power
for switching

COMM (Ethernet 
link communication 
status)

Blinking green indicates 
activity

Power Supply

AC Power ( ) Green Not illuminated:  AC failure

DC Power ( ) Green Not illuminated:  DC failure

Temperature ( ) Not illuminated Amber:  power supply is over temperature

CPU

COMM (Ethernet 
link communication 
status)

Blinking green indicates 
activity when linked via 
Ethernet connector

STATUS Blinking green
Blinking red/green:  an exception has been 
logged in IOS (validation failure)
Blinking red:  dropped into IOS
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Power
screen
APWeb

For startup information, see the APWeb Server Module’s documentation.

HyperTerminal

When power is applied to the enclosure, HyperTerminal displays a one-line splash screen followed by 
“Ready” (FIG. 20). The system is ready to disconnect the factory default switch and to execute a test 
switch (see page 38). If you need to access advanced system information, see 
“Appendix D – Programmer’s Interface for System Diagnostics” on page 91.

Note: AMX reserves the right to add to the contents of the splash screen at any time, without notice.

Redundant Power Supply (RPS)
Each enclosure ships with up to four mutually-redundant (hot-swappable) power supplies.

Depending on how many power supplies are in the system and the load of the system, the RPS indicator 
on the front of the enclosure may blink (red or green) if there is a problem. Check the AC and DC LED 
indicators on the rear of the enclosure directly above each power receptacle to determine if a power 
supply is not working.

For additional LED indicator information, see page 36.

Important: A failed power supply should be replaced as soon as possible to maintain the system’s 
power redundancy. For replacement information, contact technical support (see page 40). 

Troubleshooting

If a power supply’s AC and DC power indicator LEDs are not illuminated:

T Check to be sure the power cord is completely plugged in.

If the AC and DC LEDs remain unilluminated, contact technical support (see page 40).

Caution: Do not remove a failed power supply until you have the replacement and are ready to 
install it, unless directed to do so by technical support. The Epica DG enclosure is able to operate 
normally with a failed RPS; however, a failed RPS may prevent the Epica DG from re-booting 
properly if the system is powered down.

FIG. 20  Power-up splash screen in HyperTerminal

(1:Enclosure) AutoPatch Epica DG

Ready

 up splash 
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Executing a Test Switch
For new system installations, we recommend executing a test switch to verify the system is working 
properly before attaching all inputs and outputs. Aside from having signal cables and a controller 
attached, the system is ready to execute switches when it ships from the factory.

The first two source and destination devices must be attached to the input and output connectors as 
indicated in the “AutoPatch Connector Guide” that is shipped with each system (for specific board 
connector information and specifications, see the specific board chapter in this manual). After the 
devices are connected, power must be applied to the enclosure and then to the devices before executing a 
test switch.

You can execute a test switch from the following:

z AMX control device

z Control software, such as, APControl 3.0.1 or APWeb

z BCS (Basic Control Structure) commands over an external controller 

z An external third-party controller

Executing a Test Switch

Before executing the test switch, make sure the first two source devices and the first two destination 
devices are connected to the input and output connectors exactly as shown on the “AutoPatch Connector 
Guide” that is shipped with each system. Any applicable signal conversion modules must also be 
installed (see the module’s documentation).

When executing a test switch, we suggest routing Input (source) 1 to Output (destination) 2 on the 
virtual matrix or level indicated on the “AutoPatch Connector Guide.”

After the test switch has executed successfully, you may need to adjust the image with the software 
that is provided on the AMX AutoPatch CD (also available at www.amx.com).

z EDID Programmer software is used for programming the input boards if necessary 
(see “Appendix A – EDID Programmer” on page 61). 

z Board configuration software can be used to adjust the source signal for optimal display 
(see page 52). For information on the DG HD-15 Wizard, see the “Epica DG RGBHV/HD-15 
Boards” chapter on page 49. For information on other types of board configuration wizards, 
see the specific signal conversion module’s documentation.

AMX Control Device

For executing and disconnecting switches, see the instruction manual for the specific interface.

APControl 3.0.1 or APWeb

Directions for executing and disconnecting switches using APControl 3.0.1 are found in its Help file. 
For directions for executing switches using APWeb, see the APWeb Server Module’s documentation.

BCS Commands

To enter BCS commands, the system must be attached to a serial control device (see page 26, “Attaching 
External Controllers”) running a terminal emulation program (such as, HyperTerminal). The settings on 
the PC serial communication software and the enclosure must correspond to each other. For setting 
information, see page 28.

When using HyperTerminal, command characters are entered and sent to the enclosure’s CPU (the 
command characters appear in HyperTerminal when the enclosure responds). When all of the entered 
characters appear in HyperTerminal, the command has been successfully executed. 
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The following test switch routes Input 1 to Output 2 on Level 0 (or use the level indicated on your 
“AutoPatch Connector Guide”). 

To execute the test switch:

1. Enter the following BCS command line:
CL0I1O2T

When the “T” appears, the system has successfully executed the command. If any other character(s) 
appears, the command was not successful. Verify that the source signal is present (visible and/or audible) 
at the destination.

For a complete list of BCS commands and responses, see the BCS Protocol Instruction Manual on the 
AMX AutoPatch CD or at www.amx.com.

Troubleshooting

If the test switch did not execute correctly:

T  Check the power indicator on the front of the enclosure. 
If it is not illuminated, check the power cords. 

T  Verify the status of the test switch. 
If using BCS commands, enter “SL0O2T”. If “SL0O2T(1)” appears, the test switch is 
routed.
If the status returns as routed correctly, the system established a connection between the 
specified input and output connectors within the enclosure. 

T  Check all link and signal connections on the rear of the enclosure(s) to make sure everything is 
physically set up correctly.

T  Check all power switches on the source and destination devices to make sure they are all 
turned on.

T Depending on the board type:

z Isolate source/destination equipment and cable problems by patching around the router 
using cable adapters (FIG. 21) to check the overall signal path.

z Check the MTP® fiber connectors to make sure they are fully inserted into the fiber 
module and that there is no dust or debris on the exposed fiber ends of the cable or on the 
module.

z Check the documentation for the fiber conversion modules to be sure they are installed 
correctly. Isolate source and destination devices using the fiber conversion modules to 
bypass the enclosure to check the fiber cable and overall signal path.

T  Attempt the switch again.
If the switch still does not work, contact technical support (see page 40).

FIG. 21  DVI cable adapter
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Technical Support
Before contacting technical support with a question, please consult this manual. If you still have 
questions, contact your AMX representative or technical support. Have your system’s serial number 
(normally located on the rear of the enclosure) ready.

We recommend recording your system’s serial number in an easily accessible location.

AMX Contact Information

z 3000 Research Drive, Richardson, TX 75082

z 800.222.0193

z 469.624.8000

z Fax 469.624.7153

z Technical Support 800.932.6993

z www.amx.com
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Epica DG DVI (Digital Visual Interface) Boards

Applicability Notice

This chapter pertains to the following Epica DG (Digital Generation) DVI boards:

z FG1055-416     Input board

z FG1055-419     Output board

Epica DG enclosures are built to hold up to eighteen DG DVI boards with eight DVI-I and four DMS-59 
connectors each. The DMS-59 connectors break out to allow two DVI connections each for a total of 
16 inputs or outputs per board. Each enclosure holds a maximum of nine input and nine output boards, 
accommodating connector configurations up to a maximum of 144x144, as well as subsets in increments 
of sixteen (e.g., 128x64 or 80x112).

Generally, DG DVI input boards route signals to other types of Epica DG boards, and DG DVI output 
boards can accept signals from other types of Epica DG boards. When routing from one board type to 
another, the Epica DG automatically converts the signal format to match the output board.

DG DVI boards only route single link DVI-D signals. However, they have DVI-I connectors, which 
allow use of cables with DVI-D connectors or with DVI-I connectors. The DG DVI boards also have 
local DDC (Display Data Channel) support with plug-and-play information provided by the Epica DG 
Distribution Matrix. 

Note: The DG DVI board does not support HDCP required compliant signals.

EDID Programmer software is included on the AMX AutoPatch CD (also available at www.amx.com) 
for programming the input boards if necessary (see “Appendix A – EDID Programmer” on page 61).

FIG. 22  Epica DG DVI boards
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Specifications Epica DG DVI
Applies to DG DVI input board FG1055-416 and output board FG1055-419.

EDID Resolutions Supported through Local DDC*

Standard Timings

Established Timings

AMX reserves the right to modify its products and their specifications without notice.

Epica DG DVI Specifications

Parameter Value

Pixel Bandwidth (bit rate) 1.65 Gbps

Resolution Support Up to 1920x1200 @ 60 Hz refresh rate (with reduced sync blanking)

Specification Compliant DVI 1.0, DVI-D single link

Input Cable Equalization Up to 50 ft. (15.24 m)

DDC/EDID Support EDID resolutions provided by the Epica DG

HDCP Supported No

Reclocking (output) Yes

Connector Types DVI-I, use with DVI-I or DVI-D cables (DVI-D is the supported signal type)

Standard Timing
 Identification

Resolutions Refresh Rate 
Max.**

ID 1 1920x1200 Included in the Detailed Timing Block 
with reduced sync blanking

60 Hz

ID 2 1920x1080 Included in the Detailed Timing Block 
with reduced sync blanking

60 Hz

ID 3 1680x1050 60 Hz

ID 4 1600x1200 60 Hz

ID 5 1280x800 60 Hz

ID 6 1280x720 60 Hz

ID 7 1280x1024 60 Hz

ID 8 640x480 120 Hz

Resolutions Refresh Rate Max.**

720x400 70 Hz

720x400 88 Hz

640x480 60 Hz

640x480 67 Hz

640x480 72 Hz

640x480 75 Hz

800x600 56 Hz

800x600 60 Hz

800x600 72 Hz

800x600 75 Hz

832x624 75 Hz

1024x768 60 Hz

1024x768 70 Hz

1024x768 75 Hz

1024x768 87 Hz

1280x1024 75 Hz

1152x870 75 Hz

* Additional resolutions may be supported through local DDC.
** Some monitors may not support the maximum refresh rate.
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Attaching Cables
When attaching DVI input and output cables, refer to the sheet labeled “AutoPatch Connector Guide” 
that shipped with the system. The sheet shows where to attach each cable on the rear of each enclosure. 
Follow the sheet exactly; the system was programmed at the factory to operate only as indicated on the 
sheet.

To connect DVI inputs and outputs: 

1. Fasten the DVI-I (or DVI-D) connectors on the cable ends onto the DVI-I receptacles on the boards. 
(For DVI pinout information, see page 44.)

Connector Numbering Correspondence for Breakout Cable

The two DVI connectors on the DMS-59 breakout cable are labeled 1 (bottom connector) and 2 (top 
connector). They route signals according to the numbering to the left of the DMS-59* receptacle: 
1 corresponds to the receptacle number with the lower numerical value and 2 corresponds to the number 
with the higher numerical value. For example, on the DMS-59 breakout cable for Inputs 11 and 12 
(FIG. 23), the DVI connector labeled 1 routes the signal for Input 11 and the DVI connector labeled 2 
routes the signal for Input 12.

* The configuration file and the internal pathways define each DMS-59 connection as two discrete signal 
paths for routing.

To connect DMS-59 inputs and outputs:

1. Fasten the breakout cables onto the input and output DMS-59 connectors on the board (FIG. 23).

2. Fasten the DVI cable connectors to the breakout cables (be sure to read “Connector Numbering 
Correspondence for Breakout Cable” above).

FIG. 23  Fasten cables onto input and output connectors

DMS-59 connector
(two input or output 
channels each)

DVI-I connector

Read “Connector Numbering Correspondence
for Breakout Cable” below
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DVI Pinout

Pinout information for the DVI-I connector on the DG DVI input and output boards is provided in the 
chart below FIG. 24.

* On the input connector, pin 14 is a +5 V sink. On the output connector, pin 14 is a +5 V source with a maximum 
current limitation of 55 mA.

FIG. 24  DVI-I connector pinout

DVI-I Pinout Information

1. Data 2-  9.  Data 1- 17. Data 0- C1. No connect

2. Data 2+ 10. Data 1+ 18. Data 0+ C2. No connect

3. Ground 11. Ground 19. Ground C3. No connect

4. No connect 12. No connect 20. No connect C4. No connect

5. No connect 13. No connect 21. No connect C5. No connect

6. DDC-CLK 14. +5 V* 22. Ground

7. DDC-Data 15. Ground 23. CLK+

8. No connect 16. Hot-Detect 24. CLK-
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Epica DG MTP® Fiber Boards

Applicability Notice

This chapter pertains to the following Epica DG (Digital Generation) MTP® Fiber boards:

z FG1055-410     Input board 

z FG1055-413     Output board

Epica DG enclosures are built to hold up to eighteen DG MTP® Fiber boards with 16 inputs or outputs 
per board. Each board has five MTP®/MPO fiber connectors and one DVI-I connector (DVI format). 
The MTP® fiber connectors support three I/O channels that can be individually switched.

Each enclosure holds a maximum of nine input and nine output boards, accommodating connector 
configurations up to a maximum of 144x144, as well as subsets (for example, 128x64 or 80x112).

DG MTP® Fiber input boards route signals to any other type of Epica DG boards, and 
DG MTP® Fiber output boards can accept signals from any other type of Epica DG boards. 
When routing signals between different board types, the Epica DG automatically converts the signal 
format to match the output board.

System Setup

DG MTP® Fiber input boards are used in conjunction with AMX AutoPatch signal conversion modules. 
For module installation details, see the specific module’s quick start guide. Board configuration software 
is provided with the modules to adjust the source signal for optimal display.
MTP® is a registered trademark of US Conec, Ltd.

FIG. 25  Epica DG MTP® Fiber boards
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Specifications Epica DG MTP® Fiber (& Epica DG DVI)
Applies to input board FG1055-410 and output board FG1055-413.

Compatible AMX AutoPatch modules: DG RGBHV MTP® Fiber RX and TX, DG DVI MTP® Fiber TX 
and RX.

*3,000 ft. cable requires low loss, controlled skew fiber cable, such as, Alcoa 50/125 μm Laser-Link 550.

EDID Resolutions Supported through Local DDC**

** Additional resolutions may be supported through local DDC.

AMX reserves the right to modify its products and their specifications without notice.

Epica DG MTP® Fiber Specifications

Parameter Value

Resolution Support Up to 1920x1200 @ 60 Hz refresh rate (with reduced sync blanking)

Fiber Cable Types 12-fiber multi-mode MTP®, 50/125 μm (recommended) or 62.5/125 μm

Fiber Cable Length Up to 3000 ft. (914.4 m) in and 3000 ft. (914.4 m) out*

Fiber Cable Termination Female MTP®

Fiber Connector (on board) Male MTP®/MPO fiber (guide pins define it as a male)

Epica DG DVI Specifications

Parameter Value

Pixel Bandwidth (bit rate) 1.65 Gbps

Resolution Support Up to 1920x1200 @ 60 Hz refresh rate (with reduced sync blanking)

Specification Compliant DVI 1.0, DVI-D single link

Input Cable Equalization Up to 50 ft. (15.24 m)

DDC/EDID Support EDID resolution provided by the Epica DG

HDCP Supported No

Reclocking (output) Yes

Connector Types DVI-I, use with DVI-I or DVI-D cables (DVI-D is the supported signal type)

Resolutions

1920x1200 (uses reduced sync blanking) 1600x1200 1280x720 800x600

1920x1080 (uses reduced sync blanking) 1280x1024 1152x864 640x480

1680x1050 1280x768 1024x768        –
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Attaching Cables
When attaching MTP® fiber and DVI input and output cables, refer to the sheet labeled “AutoPatch 
Connector Guide” that shipped with the system. The sheet shows where to attach each cable on the rear 
of each enclosure. Follow the sheet exactly; the system was programmed at the factory to operate only as 
indicated on the sheet.

Instructions for attaching cable management bars are on page 19. These bars are recommended and 
provided with each fiber board.

Caution: Do not severely bend or kink the MTP® fiber cable. Irreversible damage can occur. Refer 
to the physical limitations (bend radius) specified for the cable.

Warning: Laser Radiation. Do not view directly with optical instruments. Class 1M laser product.
 

Check When Fastening Cables: 

z Ensure that there is no dust or debris on the exposed ends of the fiber cable connector or the 
fiber connector on the module.

z Ensure that the fiber cable connectors seat firmly into the board and fiber module connectors. 
Normally an audible click is heard when the connector engages.

To connect MTP® fiber inputs and outputs:

1. Recommended – Install the provided cable management bars (see page 19).

2. Fasten the cables onto the input and output MTP® fiber receptacles (FIG. 26).

To connect the DVI input or output: 

1. Fasten the cable onto the input and output DVI-I receptacles (FIG. 26).
(For DVI pinout information, see page 48.)

FIG. 26  Fasten cables onto input and output connectors

Warning: LASER RADIATION.
Do not view directly with optical instruments.
Class 1M laser product.
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DVI Pinout

Pinout information for the DVI connector on the DG MTP® Fiber input and output boards is provided in 
the chart below FIG. 27.

* On the input connector, pin 14 is a +5 V sink. On the output connector, pin 14 is a +5 V source with a maximum 
current limitation of 55 mA.

FIG. 27  DVI connector pinout

DVI Pinout Information

1. Data 2-  9. Data 1- 17. Data 0- C1. No connect

2. Data 2+ 10. Data 1+ 18. Data 0+ C2. No connect

3. Ground 11. Ground 19. Ground C3. No connect

4. No connect 12. No connect 20. No connect C4. No connect

5. No connect 13. No connect 21. No connect C5. No connect

6. DDC-CLK 14. +5 V* 22. Ground

7. DDC-Data 15. Ground 23. CLK+

8. No connect 16. Hot-Detect 24. CLK-
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Epica DG RGBHV/HD-15 Boards

Applicability Notice

This chapter pertains to the following Epica DG (Digital Generation) RGBHV/HD-15 boards:

z FG1055-422     Input board

z FG1055-425     Output board

Epica DG enclosures are built to hold up to eighteen DG RGBHV/HD-15 boards with sixteen HD-15         
connectors each. Each enclosure holds a maximum of nine input and nine output boards, accommodating 
connector configurations up to a maximum of 144x144, as well as subsets (e.g., 128x64 or 80x112).

DG RGBHV/HD-15 input boards route signals to any other type of Epica DG output boards, and 
DG RGBHV/HD-15 output boards can accept signals from any other type of Epica DG input boards. 
When routing signals between different board types, the Epica DG automatically converts the signal 
format (analog to digital or digital to analog) to match the output board.

Board configuration software is provided to adjust the source signal for optimal display (page 53). 
EDID Programmer software is also included for programming the input boards if necessary 
(see “Appendix A – EDID Programmer” on page 61). Both programs are on the AMX AutoPatch CD 
(also available at www.amx.com).

FIG. 28  Epica DG RGBHV/HD-15 boards
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Specifications Epica DG RGBHV/HD-15
Applies to input board FG1055-422 and output board FG1055-425.

* Uses reduced sync blanking.

AMX reserves the right to modify its products and their specifications without notice.

Attaching Cables
When attaching HD-15 input and output cables, refer to the sheet labeled “AutoPatch Connector Guide” 
that shipped with the system. The sheet shows where to attach each cable on the rear of each enclosure. 
Follow the sheet exactly; the system was programmed at the factory to operate only as indicated on the 
sheet.

Epica DG RGBHV/HD15 Specifications

Parameter Value

Resolution Support Up to 1920x1200 @ 60 Hz refresh rate*

DDC/EDID Support
(EDID resolutions 
provided by the Epica DG)

1920x1200*
1920x1080*
1680x1050
1600x1200
1280x1024
1280x768
1280x720
1152x864
1024x768
800x600
640x480

RGB Input Signal Level Range 0 to 750 mVpp

RGB Input Impedance 75 ohms

RGB Input Coupling AC

RGB Output Signal Level Range 0 to 750 mVpp

RGB Output Impedance 75 ohms

RGB Output Coupling DC

Sync Input Signal Level Range 0 to 5 V

Sync Input Impedance 510 ohms

Sync Output Signal Level Range 0 to 5 V

Sync Output Impedance 50 ohms

Connector Type HD-15
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To connect HD-15 inputs and outputs: 

1. Fasten the cables onto the input and output HD-15 connectors (FIG. 29).

HD-15 Pinout

Pinout information for the High Density HD-15 connectors on the DG RGBHV/HD-15 input and output 
boards is provided in the tables below FIG. 30.

* 55 mA supplied on output pin 9; power draw not to exceed 50 mA per port.

FIG. 29  Fasten cables onto input and output connectors

FIG. 30  HD-15 board connector pinout

Input (VESA DDC Compliant)

1. Red 6. Red GND 11. ID Bit

2. Green 7. Green GND 12. DDC SDA

3. Blue 8. Blue GND 13. Horizontal Sync

4. ID Bit 9. +5 V in DDC 14. Vertical Sync

5. GND 10. GND 15. DDC SCL

Output

1. Red 6. Red GND 11. ID Bit

2. Green 7. Green GND 12. ID Bit

3. Blue 8. Blue GND 13. Horizontal Sync

4. ID Bit 9. +5 V out DDC* 14. Vertical Sync

5. GND 10. GND 15. ID Bit
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Board Configuration
The source signal routed through a DG RGBHV/HD-15 input board may need to be adjusted to obtain 
optimal display at the destination. Board configuration software, the DG HD-15 Wizard, is provided on 
the AMX AutoPatch CD for this purpose.

System Requirements

z Control PC 

z Windows 2000© or Windows XP Professional©

z 2 MB free disk space

z 15 MB RAM

z Serial port

Control PC

The Control PC runs the DG HD-15 Wizard software, which adjusts the video source signal, as it is 
viewed on the destination monitor. The Control PC is connected with a null modem cable to the serial 
port on the Epica DG. Once the boards have been configured, the Control PC can be disconnected, unless 
further changes to the display settings are necessary.

Source PC (or any other RGB video source)

The Source PC is connected to the DG RGBHV/HD-15 input board. The Source PC must have a video 
card that supplies analog RGBHV at one of the resolution and refresh rates in the table below. If you 
need to determine the resolution and refresh rate for the Source PC, see page 53.

Destination Monitor

The Destination Monitor can be connected to any of the Epica DG output boards. Adjustments made 
with the Wizard are seen on the Destination Monitor.

Test Image Files

Three types of test image files (resolution, color bars, and phase test) for adjusting the display are 
provided on the AMX AutoPatch CD. They are located at: <installation folder>\Test Patterns. Test image 
files are opened* on the Source PC and subsequently display on the Destination Monitor.

* Adobe Acrobat Reader is required to view the test image .pdf files. Acrobat Reader is a free program 
available online at www.adobe.com.

Resolution Refresh Rate

640x480 60 - 85 Hertz

800x600 60 - 85 Hertz

1024x768 60 - 85 Hertz

1152x864 60 - 85 Hertz

1280x720 60 - 85 Hertz

1280x768 60 - 85 Hertz

1280x1024 60 - 75 Hertz

1600x1200 60 Hertz

1680x1050 60 Hertz

1920x1080 60 Hertz (reduced sync blanking only)

1920x1200 60 Hertz (reduced sync blanking only)
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Determining Resolution & Refresh Rate for Source PC

If you do not know the video card resolution and refresh rate on the Source PC, use the directions below 
to find out before attempting to adjust the video display. Because video display settings cannot be 
recalled, we strongly recommend writing this information down.

To determine video card resolution/refresh settings on Windows© operating systems:

1. Minimize all applications on the Source PC.

2. Right click on the desktop.

3. Select Properties from the shortcut menu.

4. Select the Settings tab in the Display Properties dialog box.

5. Check the Screen resolution setting (e.g., 1280x1024); write it down.

6. Click Advanced.

7. Select the Monitor tab.

8. Check the Screen refresh rate, which is expressed in Hertz; write it down. 
(If the refresh rate setting is not located under the Monitor tab, try selecting other available tabs).

9. Click Cancel on each dialog box to exit.

Important: If all of the device EDIDs do not fall within the default resolution parameters provided 
(check “Specifications” on page 50), see “Appendix A – EDID Programmer” on page 61 before 
adjusting the video with the DG HD-15 Wizard.

Adjusting the Video with the DG HD-15 Wizard

Before starting the adjustment procedure:

z Install the DG HD-15 Wizard on the Control PC. (We recommend uninstalling any versions 
of BoardConfig software prior to v1.4.0 first.)

z Connect the Control PC via a null modem cable to the serial port on the Epica DG.

z Transfer the test image files from the Control PC to the Source PC.

z Determine the resolution and refresh rate of the Source PC (see instructions above).

Adjustment Tips:

z Be sure that the source device that is sending the signal to the display monitor (or device) 
has a sharp picture before you start.

z The Destination Monitor controls may need adjusting during the following procedure.

z For some 640x480 displays, selecting an 800x600 resolution from the wizard may work best.
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To adjust the video display using the DG HD-15 Wizard:

1. Route the signal from the Source PC to the Destination Monitor.

2. On the wizard, select the source in the navigation tree in the upper left corner that corresponds to the 
input connector number for the source signal to be adjusted.

3. Use the File\Open menu and select the supplied (preset) resolution file (<installation folder>\ 
presets\defaults\DG_HD15) that matches or closely matches the Source PC’s settings. 
(The .xml file name consists of the resolution followed by the refresh rate. If not indicated, the 
refresh rate is the default of 60 Hz).

4. Select the Horizontal Resolution icon. Verify that the value above the scroll bar matches the 
horizontal value of the resolution file. If necessary, move the scroll bar as close to the correct value 
as possible and then click a scroll arrow until the value is exact. For example, for 1280x960 move 
the scroll bar as close to 1280 as possible; then click a scroll arrow until the value is exactly 1280. 

5. Select the Vertical Resolution icon and repeat the previous step for the vertical value of the 
resolution file.

Important: After a preset has been loaded and the resolution values have been verified, further 
adjustments may not be required. If this is the case, go to Step 13 to complete the procedure.

6. On the Source PC, open the test image PDF that matches the resolution setting.
If an image does not appear, change the Source PC’s video card settings to match one of the 
supported resolution files (see “Specifications” on page 50).

7. Select the Horizontal Total Pixels icon. Adjust one step at a time (click on either scroll arrow), 
watching the vertical noise lines (bands) on the Destination Monitor mover farther apart. Stop when 
the bands disappear.

8. On the Source PC, open the Colorbars.pdf file. In Acrobat Reader under the View menu, select 
Actual Size.

9. Select the Red Gain icon. Watch the color section of the image as you adjust the red gain.

10. Repeat Step 9 for the Green Gain icon and for the Blue Gain icon (you may need to go back and 
forth a few times among the colors to reach the optimal result.

FIG. 31  Select source in navigation tree

Select source to adjust
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11. Adjust the rest of the icons if needed, keeping the following tips in mind:

z Horizontal Position 

z If not working, try adjusting Horizontal Pulse Width first and then retry.
z CRT screens may need to use the screen controls to fine tune for size and position.

z Vertical Position 

z CRT screens will often go blank for a moment on each adjustment. 
z To quickly make large adjustments to CRT screens, use the Page Up / Page Down keys.

z Horizontal Pulse Width

z The default normally works well for higher resolutions.
z For lower resolutions that do not fit the display well, try increasing the value.
z Reduced blanking resolutions (>1600x1200) require a small value.

z Phase Timing

z If you try to adjust this setting and do not see a difference, adjustment is not necessary.
z If adjustment is needed, open the file PhaseTest.pdf. 

Watch the image and adjust to even out any picture variation.

12. Repeat as many of the above steps as necessary for additional sources (see Time Saving Tip below).

13. From the Options menu, select Save to System (to restore settings upon power up). 
The Save to System Dialog box opens.

14. Click OK.

15. From the File menu, select Save As to save a backup file to the PC.

16. Enter a file name, and click Save.

17. Disconnect the Control PC when finished.

Time Saving Tip: If additional source devices of the same type are connected to the same type of 
destination devices, the setting for the file saved in Step 14 can be applied to those sources; use the 
following directions.

To apply settings to multiple sources:

1. From the Options Menu, select Enable Multiple Selections.

2. Select (highlight) the label for the source whose settings need to be duplicated.

3. Click the check boxes for all sources that require the same settings as the selected source.

4. From the Options Menu, select the submenu Copy to Selected \ Current Profile.
The settings from the highlighted source are applied to all sources that were selected in Step 3.

5. Complete Steps 13 through 17 in the adjustment procedure instructions above.

FIG. 32  Select source to copy settings from; check source(s) to apply settings to

Select source whose settings need copying 

Check source(s) that require selected source’s settings
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Epica DG HD-SDI Boards

Applicability Notice

This chapter pertains to the following Epica DG (Digital Generation) HD-SDI boards:

z FG1055-434     Input board

z FG1055-437     Output board

Epica DG enclosures are built to hold up to eighteen DG HD-SDI boards with sixteen BNC connectors 
each. Each enclosure holds a maximum of nine input and nine output boards, accommodating connector 
configurations up to a maximum of 144x144, as well as subsets (for example, 128x64 or 80x112).

DG HD-SDI boards can be used to route HD-SDI signals or SD-SDI signals (see supported resolutions 
on page 58). DG HD-SDI input boards can also route signals to other types of Epica DG output boards, 
and DG HD-SDI output boards can accept signals from other types of Epica DG input boards. When 
routing signals between different board types, the Epica DG automatically converts the signal format to 
match the output board.

Important: When switching an input board other than an HD-SDI input board to an HD-SDI output 
board, the resolution switched to the output needs to be one of the supported resolutions listed in the 
HD-SDI board specifications (see page 58). 

EDID Programmer software is included on the AMX AutoPatch CD (also at www.amx.com) for 
programming the input boards if necessary (see “Appendix A – EDID Programmer” on page 61).

FIG. 33  Epica DG HD-SDI boards
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Specifications Epica DG HD-SDI
Applies to DG HD-SDI input board FG1055-434 and output board FG1055-437.

Important: If all of the source device EDIDs do not fall within the default resolution parameters 
provided below, see “Appendix A – EDID Programmer” on page 61.

Specifications Notes:

z The passing of ancillary data, including audio, is not supported.

z SMPTE 259M-C or SMPTE 292M compliant timing must be provided by the source video 
equipment when performing signal format conversion from DVI or RGBHV to SDI.

z When utilizing signal format conversion to SDI in an Epica DG system, DVI is the preferred 
source signal type. You must use the correct timing pertaining to the SMPTE standards listed 
above. AMX AutoPatch provides an EDID Library with detailed timings that match the 
SMPTE standards. The EDID Library also provides preset files to use to configure the 
RGBHV board inputs (using the DG HD-15 Wizard) when routing signals to SDI outputs. 
These files are available at www.amx.com.

AMX reserves the right to modify its products and their specifications without notice.

Epica DG HD-SDI Specifications

Parameter Value

Standard SMPTE 292M (HD-SDI standard), SMPTE 259M-C (SD-SDI standard) 

Bit Rates 270 Mbps, 1.485 Gbps 

Data Type 8 bit or 10 bit

Input Level (max.) 0.8 Vpp, ±10%

Input Impedance 75 ohms

Output Level (max.) 0.8 Vpp, ±10%

Output Impedance 75 ohms

Jitter <0.2 UI

Rise and Fall Time <750 ps, ±100 ps (20% to 80%)

Rise and Fall Overshoot <10%

Auto Cable Equalization Up to 1312 ft. (400 m) of Belden 1694A or equivalent @ 270 Mbps
Up to 919 ft. (280 m) of Belden 8281 or equivalent @ 270 Mbps
Up to 656 ft. (200 m) of Belden 1694A or equivalent @ 1.485 Gbps
Up to 328 ft. (100 m) of Belden 8281 or equivalent @ 1.485 Gbps 

Auto Data Rate Lock Yes

CDR (Reclocking) Yes

Connector Type BNC

Resolutions Supported 
SMPTE 259M-C

480i (525) @ 59.94 Hz
576i (625) @ 50 Hz

Resolutions Supported 
SMPTE 292M

720p @ 60 Hz, 59.94 Hz, 50 Hz, 30 Hz, 29.97 Hz, 25 Hz, 24 Hz, 23.98 Hz
1080i @ 60 Hz, 59.94 Hz, 50 Hz
1080p @ 30 Hz, 29.97 Hz, 25 Hz, 24 Hz, 23.98 Hz
1080PsF @ 24 Hz, 23.98 Hz
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Attaching Cables
When attaching BNC input and output cables, refer to the sheet labeled “AutoPatch Connector Guide” 
that shipped with the system. The sheet shows where to attach each cable on the rear of each enclosure. 
Follow the sheet exactly; the system was programmed at the factory to operate only as indicated on the 
sheet.

To connect BNC inputs and outputs: 

1. Fasten the cables onto the input and output BNC connectors (FIG. 34).

Terminating Connectors

For optimal performance, add 75-ohm terminating connectors to all unused outputs (FIG. 35).

FIG. 34  Fasten cables onto input and output connectors

FIG. 35  Add 75-ohm terminating connectors to unused outputs

75-ohm terminating connectors
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Appendix A – EDID Programmer

EDID Programmer software is provided for programming the EDID EEPROM chips on the Epica DG 
DVI and RGBHV/HD-15 input boards if necessary. This software is available (along with board 
configuration software) on the AMX AutoPatch CD or at www.amx.com.

Note: Board configuration software is used to adjust the source signal for optimal display at 
the destination. For information on the DG HD-15 Wizard, see the “Epica DG RGBHV/HD-15 
Boards” chapter on page 49. For information on other types of board configuration wizards, see the 
specific signal conversion module’s documentation.

EDID Overview
EDID (Extended Display Identification Data) is a data structure established by the Video Electronics 
Standards Association (VESA) to enable plug-and-play support by enabling easy configuration of 
a computer’s graphics subsystem based on the capabilities of the attached display device.

EDID information includes items such as the following:

z Manufacturer’s name 
z Product type 
z Supported video resolutions and refresh rates
z Color space and filter chromaticity 
z Detailed timings

When a computer is directly connected to a display device, it can use the display device’s EDID 
information to determine an initial compatible video signal to send. With the computer’s display 
controls, the user can modify this selection to another compatible signal based on the provided EDID 
information.

With DVI (which requires EDID on the display devices), using EDID information has extended beyond 
computers to other source devices, such as DVD players. As long as the source device sends a 
compatible signal, the plug-and-play feature will work.

Matrix Switchers and EDID

Matrix switchers, such as the Epica DG, provide the ability to route one source signal to many potentially 
different types of display devices. As long as the source signal being routed is supported by all of the 
display devices, the result would be a good image on each display. If the source signal being routed is not 
supported by a display device, the result would be either a badly distorted image or no image at all.

To address these issues, the DG DVI board and the DG RGBHV/HD-15 board come with one EDID 
EEPROM chip per input connector, which has been pre-loaded with an AMX AutoPatch EDID set. This 
EDID set consists of 24 of the most common EDID settings in use today, including all VESA 
Established Timings encompassing 8 resolutions at a variety of refresh rates and 8 additional Standard 
Timings encompassing 8 resolutions and refresh rate combinations (for timing details, see page 42). In 
many cases, the matrix switcher can be used straight out of the box with no adjustments (see 
“Determining the Need for EDID Programming” on page 62).

The EDID Programmer software has been provided for cases where additional in-field programming of 
the EDID chips is needed. The Programmer can be used for the following:

z Reading and saving EDID data from a device

z Writing EDID data to an AMX AutoPatch matrix switcher’s input connector’s associated 
EDID EEPROM
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Note: Any analysis or editing of the EDID data necessary to support the equipment specific to your 
installation will need to be done separately prior to using the EDID Programmer. A variety of 
freeware tools can be found on the web to help with these tasks.

Keep in mind that the EDID information for some equipment may not be compatible with the remaining 
equipment even with programming. In those cases, the signals will have limited routing options.

Tip: If the signal from some of the equipment can only be routed to part of the destinations due to 
incompatible EDIDs, control can be simplified by creating a separate virtual matrix (level) for the 
inputs and outputs involved.

The remaining sections provide information on:

z Determining the need for EDID programming

z Installing the EDID Programmer

z Reading and saving EDID data from a destination device

z Writing data to an Epica DG input connector

Determining the Need for EDID Programming
Ideally the EDID analysis will have been completed during installation specification. If this was not 
possible but all of the system’s devices are now available, the most effective way to proceed is to test if 
the signal from each of the source devices can be routed through the Epica DG to each of the destination 
devices. If they can be routed, then EDID programming is not necessary. 

A method of control is not specified in the following instructions.

To determine if EDID programming is necessary:

1. Route the first input to all of the applicable outputs.

2. Check each destination display to verify that the picture is present, making note of any that are not.

3. Repeat the Steps 1 and 2 for each of the remaining inputs.

Important: If any of the destinations do not display a picture, analysis or editing of the EDID data 
may be necessary prior to using the EDID Programmer. A variety of freeware tools can be found on 
the web to help with these tasks.

 

Installing the EDID Programmer
PC System Requirements (v1.0.0)

T Windows 2000© or Windows XP Professional© 

T Minimum Hardware: 166 MHz, 128 MB RAM, 20 MB of free disk space*, 800x600 display, 
serial port, video card with dual outputs**

T Recommended Hardware: 2.0 GHz, 512 MB RAM*

* The installation process requires 20 MB of disk space for the EDID Programmer installer. Once 
installed, the EDID Programmer requires 5 MB of disk space.
** We strongly urge the user not to use video cards with DMS-59 connectors. Video cards with DMS-59 
connectors have been shown to fail consistently and, in the worst case, can corrupt an EDID data file. A 
laptop PC with a VGA or DVI out is a good solution. Cards with 2 DVI connectors, 2 VGA connectors, 
or 1 DVI and 1 VGA connector are also acceptable.
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To install EDID Programmer software:
1. Locate and open the installer <EDIDProgrammer_1.0.exe> on the AMX AutoPatch CD or at 

www.amx.com.

2. Follow the directions in the wizard.

Reading and Saving EDID Data from a Destination Device
Tip: The Save button in the EDID Programmer can be used to save the EDID information as an 
.edid file, which can be opened as a text file (click on the Open button) and edited or opened and 
written to an input (click the Write button).

The instructions below cover the situation in which the EDID Programmer is used to read the EDID 
information from a destination device in the installation with a DVI connector (an HD-15 connector can 
also be used). Additional information for using DVI cable is provided below the “read and save” 
instructions.

To read and save EDID data:

1. On the PC, open the EDID Programmer (FIG. 38 on page 64).

2. Connect a DVI cable to the PC using the PC’s spare monitor port (see “Using Cable Adapters” 
below).

3. Connect the open end of the DVI video cable to the destination device (typically a monitor) from 
which the EDID information needs to be read.

4. Click the Refresh Display List button to update the Available Displays drop down list.

5. From the Available Displays drop down list, select the destination device from which you need to 
read the EDID.

6. Click the Read button to read the EDID information. The results display in the read-only area.

7. Click the Save button (select location, enter file name, and click Save).

8. Disconnect the DVI cable from the PC and from the destination device.

Using Cable Adapters

If your laptop has an HD-15 (VGA) port, you can use a DVI-to-VGA cable to connect the laptop’s 
HD-15 video port to a DVI cable attached to a destination device’s DVI port. Alternatively, use the 
following combination of adapters with a DVI-D cable to connect the laptop to the destination device: 

Note: The setup of adapters and DVI-D cable in FIG. 36 passes EDID information but not video 
signals.

Writing EDID Data to an Epica DG DVI Input Connector
The instructions that follow cover the situation in which the EDID Programmer is used to write EDID 
information to the EDID chip for an input connector on a previously unprogrammed DG DVI input 
board. 

A previously unprogrammed DG RGBHV/HD-15 input board can be programmed using the same 
instructions; use an HD-15 video cable instead of a DVI cable.

FIG. 36  Connecting an HD-15 (VGA) port to a DVI port

PC or 
Laptop

Female VGA (HD-15) adapter 
to Male DVI-I adapter

DVI-I Female to 
DVI-Female adapter

Male DVI-D to 
Male DVI-D cable

Destination 
Device
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To write EDID data to the EDID chip for an input connector:

1. Attach a null modem serial cable without hardware flow control to the serial port (DB-9) on the 
Epica DG. Use a serial cable that matches the pin diagram in FIG. 37 for RS-232. AMX AutoPatch 
equipment uses pins 2, 3, and 5 only.

2. Attach the open end of the serial cable to the PC that the EDID Programmer will be opened on.

3. Use serial communication software to make sure the PC’s baud rate is set correctly for the system. 
The recommended (default) settings for serial communication with an Epica DG are: 
baud rate – 9600, data bits – 8, parity – none, stop bits – 1, and flow control – none. 

4. Apply power to the enclosure.

5. On the PC, open the EDID Programmer. 

6. Click the Query AutoPatch Device button to obtain the enclosure address from the Epica DG.

7. Connect a DVI video cable to the PC using the PC’s spare monitor port.

8. Connect the open end of the DVI video cable to the DVI input connector on the Epica DG that 
requires programming.

FIG. 37  RS-232 pinout

FIG. 38  EDID Programmer

Available Displays drop down list – select device 

Close – will not prompt to save

 

Open – an EDID file
Save – an EDID file to edit or to write to input on board

Refresh Display List – updates list after additional devices attached

Convert to Digital / Convert to Analog – converts displayed EDID data 

Query AutoPatch Device – acquires enclosure’s XNNet ID address

EDID Information – data (read-only) from file or device 

EDID Type – indicates analog or digital (read-only)

Read – reads EDID from selected destination device 
Write – writes EDID to input on board

Communication menu – use to select PC serial port or change baud rate

Status – shows application status (read-only)
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9. Save board’s EDID default as a backup.  
– Click the Refresh Display List button. 
– Select the device. 
– Click the Read button. 
– Click the Save button (select location, enter file name, and click Save).
This step assumes that the input connector has not been programmed with EDID data since it 
shipped from the factory.

10. Click the Open button to select the .edid file to be written to the DVI input connector.

11. Click the Write button to write the EDID information to the DVI board.

12. If applicable – Repeat any of the steps necessary for any of the other DVI input connectors.

13. Disconnect the DVI video cable from the PC and from the Epica DG input board.

14. Disconnect the serial cable from the PC and from the Epica DG enclosure.

Important: Depending on the type of equipment used, you may need to select the Convert to Digital 
/ Convert to Analog button in the EDID Programmer. For example – if a PC’s digital signal is routed 
to a DG DVI input board, converted to analog, and routed through a DG RGBHV/HD-15 output 
board to a monitor with a HD-15 (analog) port, then open the EDID file and click the Convert to 
Digital button before writing that EDID to the input connector on the board.
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Appendix B – Managing Configuration Files

Applicability Notice: This chapter applies to XNConnect version 2.6.0. (XNConnect’s version 
information is found under its Help menu.)

This chapter covers basic modifications that can be made to a configuration file using XNConnect 
software. For complete coverage of XNConnect, see the Help file.

A configuration file contains system* configuration information which is loaded onto the system at the 
factory. Each enclosure’s CPU references the configuration file, which defines switching behavior. The 
file can be modified using XNConnect (found on the AMX AutoPatch CD) to include custom channel 
names and local presets.

Caution: Use XNConnect only if you need to reload the configuration file or modify your system’s 
configuration from the original specifications. Make a copy of the current file every time the 
file is modified.

A copy of the configuration file (with an .xcl file extension) is found on the AMX AutoPatch CD shipped 
with each system. If you lose the AMX AutoPatch CD, either download XNConnect from the AMX 
website and see Discovering a System on page 70 or contact technical support (see page 40) with your 
system’s serial number for a replacement file. If making any modifications other than customizing 
channel names or creating local presets, provide technical support with a copy of the modified file for 
future support.

This chapter covers the following topics: 

z Installing XNConnect

z Opening a configuration file

z Discovering a system 

z Navigating the interface

z Customizing channel names (labels)

z Creating local presets

z Loading a configuration file 

* A system can be a stand-alone matrix switcher or multiple matrix switchers with or without additional 
controllers and accessories.
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Installing XNConnect
Use this software only if you need to customize or change the configuration information from the 
original specification.

Note: Even if XNConnect is already on your PC, install the newest version that shipped on the same 
CD as the configuration file. We strongly recommend uninstalling the old version of XNConnect 
before installing a new version.

System Requirements

z Windows 2000®, Windows NT®, or Windows XP Professional®

z 233 MHz processor

z Minimum of 128 MB of RAM

z 20 MB of available hard drive space

z 800x600 screen resolution (1024x768 is recommended)

z Serial port and RS-232 null modem cable

If you cannot locate the AMX AutoPatch CD that shipped with your system, see Discovering a System 
on page 70.

To install XNConnect from the AMX AutoPatch CD:

1. Close all other applications currently running on your PC.

2. Insert the AMX AutoPatch CD into your CD drive to start automatically.
If the CD does not autorun, explore the CD folder and double-click the Index.html file.

3. Select Software and find XNConnect.

4. Optional – Select Release Notes to read about the software before installation.

5. Select Install. 

6. Follow the directions in the subsequent dialog boxes.

Note: The newest version of XNConnect is available at www.amx.com. An INI file Updater can also 
be found on the AMX website for updating XNConnect with information for new support devices and 
I/O boards.

Opening a Configuration File
The process of modifying a configuration file starts by opening it with XNConnect. After the 
modifications are complete, the new configuration information must be loaded onto the system to 
implement the changes.

Note: Even if XNConnect is already on your PC, install the newest version that shipped on the same 
CD as the configuration file. We strongly recommend uninstalling the old version of XNConnect 
before installing a new version.

If you cannot locate the original factory configuration file, see Discovering a System on page 70.
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Caution: Use XNConnect only if you need to reload the configuration file or modify your system’s 
configuration from the original specification. Make a copy of the original file every time the file is 
modified.

To launch XNConnect:

1. From the Start menu, select Programs.

2. Select AutoPatch Applications (or other file group you specified during the installation).

3. Select the XNConnect folder.

4. Select XNConnect.
The XNConnect program opens.

5. From the Getting Started dialog box, click Open Configuration File. 
(If the dialog box does not appear, from the File menu select Open.)

6. Use the standard Open dialog box to locate and open your configuration (.xcl) file. 
The default location is in the MyXCL folder on the AMX AutoPatch CD.

7. Using Save As (under the File menu), make a duplicate copy of the file with a new name and save it 
to the PC. (We strongly recommend making a duplicate copy every time the file is modified.)

The file is ready to be modified. If changes are made, the new file must be loaded onto the system to 
implement the changes (see page 75).

Getting Started
Dialog Box
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Discovering a System
If you lose your AMX AutoPatch CD with the original configuration file, contact technical support
(see page 40) with your system’s serial number for a replacement copy of the original configuration file. 
Or download XNConnect and the INI Updater from www.amx.com and follow the instructions below to 
discover your system.

The discovery process queries the attached system for configuration information and properties, 
including information regarding assigned signals and virtual matrix definitions. The discovery process 
may take several minutes to complete. We recommend disconnecting any third-party control devices 
from the enclosure’s serial ports before starting the discovery process.

To discover a system:

1. Disconnect any third-party control devices from the Epica DG enclosure’s serial port or USB port.

2. Connect the enclosure* to your computer (page 27).

3. Launch XNConnect (see page 69).

4. Open the Communication menu; select Serial Port.

5. If applicable – For a serial port other than Com 1, open the Communication menu again, select 
Change Comm Settings, and adjust the settings for the selected port (default baud rate 9600). 

6. From the File menu, select Discover System (the discovery may take a few minutes).

7. Save the discovered system’s configuration file, make a duplicate copy with a new name, and save it 
to the PC.
The new configuration file is ready to be modified. If changes are made, the new file must be loaded 
onto the system to implement the changes (see page 75).

* For systems with multiple enclosures, you can connect any of the enclosures to the PC as long as 
all of the enclosures are linked together.
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Navigating the Interface
XNConnect displays configuration information in two panes. The graphics are located in the left pane, 
and the properties of the currently selected graphic are in the right pane. At the top of the left pane are 
two tabs, Hardware and Virtual Matrices, for accessing the Hardware and Virtual Matrix views 
(see below). To see the details and components of a device or a virtual matrix, click the plus “+” symbol 
to the left of the device or the virtual matrix.

Most configuration file modifications involve entering information in a series of dialog boxes that are 
accessed by right-clicking a hardware device or virtual matrix icon and selecting an option from the 
shortcut menu. If you have a question regarding an open dialog box, press the F1 key for Help.

Hardware View

The Hardware view displays the system’s hardware, such as enclosures and serial ports.

Virtual Matrix View

The Virtual Matrix view displays properties of the existing virtual matrices. Most common tasks are 
conducted from this view, including customizing channel names and creating local presets.

Hardware Tab Virtual Matrices Tab Highlighted Device Properties of Highlighted Device

Device Firmware Version

Primary

This view will also show linked

Components of the
Primary Device

Device

AMX AutoPatch Primary Devices

Communication Settings
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Modifying a Configuration File
Modifying a configuration file with XNConnect involves entering information in a field or in a series of 
dialog boxes. A brief look at the contents in the Help file provides a quick overview of the possible 
modifications.

This section provides instructions for two common tasks: modifying channel names and configuring 
local presets. For complete coverage of configuration related tasks, see the XNConnect Help file.

Modifying Source & Destination Channel Names

If the system is using APWeb for control, the names for the source and destination channels displayed in 
the XBar can be customized in XNConnect. The custom names (labels) can be up to 23 characters and 
cannot contain the following characters: ‘  “  \  =  ?  <  >

To customize the channel names:

1. In the Virtual Matrices view, click the “+” to the left of the Virtual Matrix.

2. Click the “+” to the left of the Sources or Destinations folder.

3. Right-click the channel you want to rename and select Change Name from the shortcut menu.

4. Enter the new name in the Input Text dialog box and click OK.
The new channel name appears in the Name field.

Note: If a channel is in more than one VM, you must repeat Step 4 for the channel in 
each of the VMs.

5. Customize additional channels by repeating Steps 3 and 4.

When finished, load the configuration file onto the system (see page 75). If channel names are the only 
modifications that have been made to the file, use the “Configure System Namespace” option (found 
under Configure \ Configure Special – Virtual Matrix).

Caution: The system must not be actively switching when loading this information onto the system.

Name Field 

Customized Channel Name

Enter Channel Name

Default Channel Name

(displays selected channel)
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Creating Local Presets

A local preset is a predetermined collection of switches (on the same virtual matrix) to be routed 
simultaneously. Executing a local preset affects only those inputs and outputs specified, not the whole 
system. Local presets are defined using XNConnect and can be executed using BCS commands entered 
as part of a macro in APControl 3.0 or APWeb or entered in a terminal emulation program. The process 
for creating local presets involves three dialog boxes that cover managing, naming, and modifying 
presets.

The instructions below are for creating a local preset. For detailed information on modifying and 
deleting local presets, see the XNConnect Help file.

To create a new preset:

1. In the Virtual Matrices view, right-click the virtual matrix the preset will be created for and select 
Manage Local Presets from the shortcut menu.
The Manage Local Presets dialog box opens.

2. Click the Name New button.
The Name New Preset dialog box opens.

3. Optional – Enter a different preset number (local presets do not need to be numbered sequentially).

4. Enter a name for the new preset.

5. Optional – Enter a description.

6. Click OK.
The Modify Preset dialog box opens.
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7. For the first switch, click the source channel (input) and one or more destination channels (outputs). 
Select multiple destination channels by holding down the Control key while selecting the channels.

8. Click the Assign Switch button. 
The input appears in the Assignment column of the Destination Channels list; the switch will 
execute when the local preset is executed.

9. Disconnect inputs* or outputs as part of the local preset by selecting either the source or destination 
channel and clicking the Disconnect button.
The input or output appears in its corresponding Disconnected Channels list; the input or output will 
be disconnected when the local preset is executed.

10. Repeat Steps 7, 8, and 9 for all switches and/or disconnects to be included in the preset.

Note: For information on the other buttons and preset modifications, press F1 while the 
Manage Local Presets dialog box is open.

11. After all switches for the preset have been assigned, click OK and then close the Manage Local 
Presets dialog box.

Define additional local presets by repeating the steps. When all local presets have been defined, load the 
configuration file onto the system (page 75). If local presets are the only modifications that have been 
made to the Configuration file, use the “Configure All Local Presets” option.

Caution: The system must not be actively switching when loading this information onto the system

* Disconnecting an input will disconnect all outputs it is connected to.

The Disconnected Channels box 
shows that Output 1 will be 
disconnected as part of Preset 1.

The Assignment column shows 
three switches that will be 
executed as part of Preset 1: 
Input 2 to Output 5
Input 3 to Output 6 
Input 7 to Output 8
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Loading a Configuration File
Once modifications have been made to the configuration file, the new file must be loaded onto the 
system’s CPU for the changes to be implemented.

There are two basic options for loading a configuration file:

z Load the entire file using the “Configure All” option (see Caution below).

z Load part of the file using one of the “Configure Special” options.

To determine which configuration option to use, see “Configure Menu Commands” in the Help file.

When loading any part of a configuration file, the matrix switcher must not be actively switching. You 
may want to disconnect any external controllers to ensure that no switches are executed during the 
loading of the file.

Caution: Using the “Configure All” option or the “Configure All Virtual Matrices” option will erase any 
global presets (see the BCS Protocol Instruction Manual) that have already been defined for the 
system. 

To load the modified configuration file from XNConnect to the Epica DG CPU:

1. Using Save As (under the File menu), make a duplicate copy of the modified file with a new name 
and save it to the PC. (We strongly recommend making a duplicate copy every time the file is 
modified.)

2. Connect the Epica DG enclosure* to your computer (see page 26).

3. Open the Communication menu and select Serial Port.

4. Open the Communication menu again, select Change Comm Settings. Check the settings for the 
selected port (the default is Com 1, Baud Rate 9600) and adjust if necessary.

5. Optional – Click the Test button to verify that communication has been established with the 
Epica DG. Click OK.

6. From the Configure menu, select the appropriate configuration option (for an explanation of 
Configuration menu options, see the Help file). 

The system automatically reboots (applies to non-hardware configuration options only; for hardware, 
select the appropriate configuration option and then Configure > Reboot All Devices).

* For systems with multiple enclosures, you can connect any of the enclosures to the PC as long as all 
the enclosures are linked together.
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Appendix C – APDiagnostics

Overview
APDiagnostics is a software application that monitors and displays advanced diagnostic information 
about the Epica DG. (APDiagnostics also works with other AMX AutoPatch products that are capable of 
reporting such data). This application is available on the AMX AutoPatch CD or at www.amx.com.

System Requirements
T Windows 2000® or Windows XP Professional®

T Java Runtime Environment (JRE):  v1.5 or the latest version

T Minimum Hardware: 166 MHz, 128 MB RAM, 20 MB of free disk space*, 
800x600 display, serial port

T Reccommended Hardware: 2.0 GHz, 512 MB RAM, 100 MB free disk space*, 
dual 1024x768 monitor display, Ethernet port**

* The installation process requires 20 MB of disk space for the APDiagnostics installer and 200 MB of 
disk space for the JRE v1.5 that is packaged with the installer (if required). Once installed, 
APDiagnostics requires 5 MB and JRE v1.5 requires approximately 100 MB of disk space.

** We strongly encourage using the Ethernet link whenever possible, due to the volume of data involved 
with monitoring diagnostics. See “Communications” on page 90.

Installing APDiagnostics 
You will need administrative rights to install APDiagnostics; contact your Network Administrator.

Note: The default port when APDiagnostics is first launched is the Ethernet port.

To install APDiagnostics using the Ethernet port (recommended):

1. Connect an RJ-45 cable to the Enc Link (Ethernet 10/100) port on the Epica DG. 
Use a null-modem crossover RJ-45 cable wired to TIA/EIA specification TIA/EIA-568-B on one 
end and TIA/EIA-568-A on the other.

2. Attach the other end of the RJ-45 cable to a PC.

3. Insert the AMX AutoPatch CD into your CD drive to start automatically. If the CD does not autorun, 
explore the CD folder and double-click the Index.html file.

4. Select Software and find APDiagnostics.

5. Optional – Select Release Notes to read about the software before installation.

6. Select Install; follow the directions in the subsequent dialog boxes

7. Open APDiagnostics in Acquisition mode.* 

8. Select Comm > Settings.

9. Select the Ethernet tab and set the NIC ID.

10. Click Accept.

* The default preference is to open APDiagnostics in Acquisition mode.
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To install APDiagnostics using the serial port:

1. Attach a null modem serial cable without hardware flow control to the serial port (DB-9) 
on the Epica DG. Use a null modem cable that matches the pin diagram below for RS-232. 
AMX AutoPatch equipment uses pins 3, 3, and 5 only.

2. Attach the other end of the null modem cable to a PC.

3. Use serial communication software to make sure the PC’s baud rate is 
set correctly for the system. The recommended (default) settings for 
serial communication for an Epica DG are provided in the table to the 
right.

4. Insert the AMX AutoPatch CD into your CD drive to start 
automatically. If the CD does not autorun, explore the CD folder and 
double-click the Index.html file.

5. Select Software and find APDiagnostics.

6. Optional – Select Release Notes to read about the software before 
installation.

7. Select Install; follow the directions in the subsequent dialog boxes

8. Open APDiagnostics in Acquisition mode.* 

9. Select Comm > Settings.

10. Select the Serial Port tab and set the Comm ID and baud rate (9600).

11. Click Accept.

* The default preference is to open APDiagnostics in Acquisition mode.

Epica DG 
Serial Port Settings

Baud Rate 9600

Data Bits 8

Parity None

Stop Bits 1

Flow Control None
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Modes
Note: If the system contains multiple enclosures, you will be prompted to select the enclosure before 
you select the mode.

This program can be opened in one of two modes: Acquisition or Emulation. 

Acquisition Mode

Note: Only a single instance of the application can run on a PC when in Acquisition mode.

Acquisition mode is used to gather and display real-time diagnostic data from an attached AMX 
AutoPatch Distribution Matrix. For this mode to be used effectively, we recommend using a dedicated 
PC because the Epica DG must be connected to your PC via the Ethernet port (default) or serial port and 
the program must be running continuously to acquire data. This data consists of system-critical 
operating parameters, as well as general information about hardware and control configuration. As the 
data is gathered, it is automatically archived on the host PC’s hard-drive. 

The three types of files maintained by APDiagnostics are: 

z Date-stamped log

z .acp (packet)

z Activity

The archived files can be emailed to technical support for trend analysis and troubleshooting or can be 
opened by APDiagnostics in Emulation mode for analysis.

Emulation Mode 

This mode is an “off-line” mode used to process and display data that was gathered from an actual 
system in Acquisition mode. This mode allows the user to “play back” the system’s behavior during a 
specified period of time for trend analysis and troubleshooting.
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Main Screen & Menus

Note: Custom window colors can be applied to the Main Screen. For instructions on modifying the 
Main Screen’s color, see the APDiagnostics Help file.

Categories Pane

The Categories pane is the left-most pane in the Main Screen and presents the highest-level information 
about the overall system status. The Categories pane has two tabs:  Diagnostics and System. 

When maximum and minimum levels of operation for various components in the system are exceeded, 
APDiagnostics flags that information as warnings or errors (depending on the data received) by 
changing the color of the Categories buttons in the Categories pane to yellow for warning or red for error 
and by displaying the information as Warnings or Errors in the Event Status Notebook.

FIG. 39  Main screen in Emulation mode (the Comm menu option is not available in this mode)

Menu
File

Load Log Files (Emulation mode only)
Zip Log File

Options
Show > Activity Log
Reload (Acquisition mode only)
Window Color
Preferences

Comm (Acquisition mode only)
Connect
Disconnect
Settings (Ethernet or serial port)

Help

Event Status Notebook

Categories Information System Visual
 Pane  Pane  Pane

Menu
80 Epica DG Instruction Manual



Appendix C – APDiagnostics
Diagnostics Tab

System Tab

The two buttons on the Diagnostics tab (Temperature and Power System) will turn 
green, yellow, or red indicating Good, Warning, or Error state, respectively. A yellow 
for warning or red for error button indicates that the maximum or minimum levels of 
functioning for various components in the system has been exceeded. This allows you 
to “drill down” into that particular system for more detailed information about the 
state of its lowest-level constituents.

To display diagnostic information for Temperature 
and Power System groups:

1. In the Categories pane, select the Diagnostics tab.

2. Click either the Temperature or Power System button. Visual, Plot, and Details 
buttons display in the Information pane (see page 82).

The five buttons on the System tab offer general information for the following:

z Enclosure Info 

z VM Configurations

z Hardware Boards 

z Power Supply Info 

z Signal Sense (for inputs)

To display general information for a particular component:

1. In the Categories pane, select the System tab.

2. Click one of the five buttons on the System tab.
The details display in the Information pane (see page 83).
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Information Pane

The Information pane is the center panel in the Main Screen 
and offers the next level of “drill down” into the system 
status. Information pane buttons access information for each 
of the specific group components listed. The type of 
information displayed in the Information pane depends on 
which tab is active in the Categories pane and which 
Categories button is selected.

To display diagnostic information:

1. In the Categories pane, select the Diagnostic tab.

2. Select either the Temperature or Power system buttons 
as applicable.

3. In the Information pane:

a. Click the Visual button to display visual details on 
the enclosure in the System Visual pane. 
For more information, see page 84.

b. Click the Plot button to display a Plot View with 
a graph of data points for information being gathered 
(Acquisition mode) or already gathered (Emulation 
mode) for a specific component. The data is date 
stamped as it is added to the graph. 
For more information, see page 83.

c. Click the Details button to display a set of analog 
status meters each representing current data for its 
associated component. The meters provide an analog 
representation of a component’s current value with 
respect to its Warning and Error setpoints. If the value 
is below its minimum or exceeds its maximum 
Warning or Error setpoint, the color of the meter 
changes from green (Good) to yellow (Warning) or 
red (Error), making it easy to identify problem areas 
at a glance.

a.

b.

c.
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Information Pane Plot Views

A Plot Views window displays a graph of data points for the components for which it is associated.
The graph has a legend at the right and is time-stamped in intervals across the bottom. The amount of 
historical data points presented in the graph can be determined by changing the settings in the 
Application Preferences dialog box (see page 86).

The legend in a Plot View is selectable; doing so will filter the view so that only the selected items are 
displayed. Furthermore, if only a single item is selected, its Warning and Error setpoint values will also 
be displayed in the window for reference.

Tip: For a hard copy of a graph, save as a .png file, then print the .png.

For information on changing the viewing of the graph, see the APDiagnostics Help file.

To display System information:

1. In the Categories pane, select the System tab.

2. Click the desired System button to display its corresponding details in the Information pane:

To access graph options:
Right click on the graph and select a shortcut menu item.

Properties – opens a Chart Properties dialog box with
three tabs:  Title, Plot, and Other.
Save as – opens a standard Save dialog box.
Print – opens a standard Page Setup dialog box.
Zoom In – provides options to zoom in on Both Axes, 
Domain Axis, or Range Axis.
Zoom Out – provides options to zoom out on Both Axes, 
Domain Axis, or Range Axis.
Auto Range – provides options for auto display of Both 
Axes, Domain Axis, or Range Axis.

z Enclosure Info – Enclosure Info, XNNet ID, Firmware Version Driver,
Version Build Date.

z VM Configurations – A table with the VM Name, VM Number, Inputs, 
and Outputs.

z Hardware Boards – A table with board numbers for Inputs, Outputs, and 
Center boards.

z Power Supply Info – Model number, Serial number, Revision, and Service 
Hours for each power supply. (If a power supply is listed as “not reporting,” 
either it is not physically present or it is not being reported by the 
enclosure.)

z Signal Sense (input) – A table indicates whether a signal is present on each 
of the input channel connections on the switcher. The signal may or may not 
be routed, but the source device must be connected and powered on for the 
table to indicate that the signal is present.

Note: The Signal Sense table does not show crosspoint status.
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System Visual Pane

Event Status Notebook

The Event Status Notebook is the panel with four tabs at the bottom of the Main Screen. The tabs in the 
Event Status Notebook provide current data (Acquisition mode) or previous data (Emulation mode). 
It provides updated status entries as the system is being monitored, providing a snapshot glance of the 
most recent state of the system.

The System Visual pane is the right-most panel in the Main Screen and 
presents a simple graphic representation of the different groups being 
monitored by the application.

To display an appropriate image in the System Visual pane:

1. In the Categories pane, select the Diagnostics tab.

2. In the Information pane, click the Visual button for the applicable 
Temperature Groups.

When components in the system exceed their 
maximum and minimum levels of operation, 
APDiagnostics flags that information as 
warnings or errors depending on the data 
received. APDiagnostics changes the color of 
the Categories buttons in the Categories pane 
(top arrow) to yellow for warning or red for error 
and displays the information as Warnings or 
Errors in the Event Status Notebook (bottom 
arrow).

The information displayed in the Event Status Notebook is sorted under the following tabs: All Events, 
Notices, Warnings, and Errors.
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Note: A yellow or red outline around a data line indicates that the component was previously in 
a Warning or Error state.

To view information in the Event Status Notebook:

1. Click the applicable tab:

z All Events – comprehensive and sequential listing of all Notices, Warnings, and Errors

z Notices (green checkmark) – data list collected indicating a status of “Good”

z Warnings (yellow !) – data list collected that indicates the Warning set point (high or low) has 
been exceeded

z Errors (red !) – data list collected that indicates an Error state, i.e., has surpassed or exceeded 
its allowable maximum or minimum set point

Data lines display for every component that is queried and provide:

z “Green checkmark” (Notice) or “yellow !” (Warning) or “red !” (Error)

z Component description (e.g., Center board 2, POL 2 power)

z General status description (e.g., GOOD, has surpassed . . ., etc.)

z Date/time-stamp for the event (e.g., 8/03/07  5:15:50 PM)

z Amount of elapsed time that the component has been in that state (e.g., 7m:25s)

To access a data line context menu:

1. Select and then right-click a data line in a list. The context menu options are: 

z Show Graph – opens a Plot View of the data points for that component

z Date/time-stamp(s)* (information only; not selectable) – indicates the most recent time that 
the component was in that respective state

z Reset Selected Item*

z Reset All Items

* These menu items only appear when a data line is outlined in yellow or red.

Tabs

Data Lines
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Types of Files

The following three types of files are zipped and archived. The file name for each includes the date and 
time zipped: for example, Diagnostic_03.02.09_14.24.50.zip (zipped on March 2, 2009 at 2:24:50 pm).

z Log (.apd, .zip) – contains all data displayed in the APDiagnostics interface in text format. 
Can be loaded when the program is opened in Emulation mode to view data for trend analysis 
and troubleshooting; see page 89.

z Packet (.acp) – contains all system activity data (packet transactions between APDiagnostics 
and the enclosure) in libpcap format. Advanced users can open .acp files with a packet/
network analyzer, such as “Analyzer” (http://analyzer.polito.it/).

z Activity (.log) – displays system activity in the Activity Log dialog box in text format.

Application Preferences

To access the Application Preferences dialog box and set preferences:

1. Select Options > Preferences.
The Preferences dialog box has two tabs: General and Logging.

General Tab

To set general application preferences:

1. For the upper set of preferences, click the applicable Enabled check boxes.

z Always Perform Live Network Discover* (selected by default)

z Open Activity Viewer at Startup

z Use Last Comm-Link at Startup (selected by default)

z Show Mode-Selection Dialog at Startup (selected by default)

z Auto-Connect in Acquisition mode (selected by default)

2. For the lower set of preferences, edit information in place (Help boxes appear).

z Emulation Mode Packet Interval

z Cached Probe History

3. Click OK.

* If this preference is “off,” the program will use the last XNNet ID stored in its registry (and expects 
that enclosure to be present).

Click to enable

Edit in place
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When processing a set of archived files in Emulation mode for analysis, you can control how fast or slow 
the files are processed by adjusting the “Emulation Mode Packet Interval” setting on the General tab of 
the Application Preferences dialog box. If you are viewing graphs while the data is being processed, 
specifying a larger interval value will allow the program to be more responsive as the Plot Views can be 
processor intensive in the face of fast playbacks.

Tip: It is important to note that APDiagnostics keeps a cache of historical data points in memory for 
status of all components that it monitors. These data points can then be displayed in the Plot Views 
for trend analysis. You can control the amount of system memory APDiagnostics will use for this 
historical data by setting the “Cached Probe History” value on the General tab. (Max. Cached Probe 
History = 168 hours. For default values, see the dialog box.) Large history sets may impede 
performance of the application, so set this value in accordance with the resources available on the 
target PC.

Logging Tab

To set the preference for Start .acp Logging At Startup:

1. Click the Enabled check box.

2. Click OK.

To change settings:

1. Edit in place (for default values, see the dialog box):

z Log File Maximum Size*

z Diagnostic Log Directory Max Size

z ACP Log Directory Max Size

z Activity Log Viewer Directory Max Size

2. Click OK.

* Log files are automatically zipped when the maximum size specified in this field is reached. This size 
value applies to all three log file types.

Tip: The amount of disk space allocated for archived files can be controlled by specifying the 
amount of disk space to allocate for each of the three file types that are generated and archived 
while APDiagnostics is running in Acquisition mode. You can also specify how big the active Log file 
should get before it is archived and a new one is started. These parameters are specified on the 
Logging tab.

Click to enable

Edit in place
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To specify the root level folder for storing all Log files:  

1. Browse the Parent Directory For Log Files.

Once specified, the files are stored as follows:

z .apd files in a subfolder named “diagnostic”

z .acp in a subfolder named “acp”

z .log files in a subfolder named “activity”

Note: The “Diagnostic Log File Name” and the “.acp Log File Name” can be changed by editing in 
place, but cannot have a specified path.

Zip Log Files

In the event that you need to zip a set of files and send them to technical support, use the Log File Zip 
Utility dialog box to create a single archive file to email.

To zip log files:  

1. Select File > Zip Log Files.

2. Click the Include check boxes for all of the files needing zipped.

z Click individually or use any of the first three option buttons along the bottom.

z Select multiple, consecutive files by holding down the Shift key and clicking the first and last 
files in a range of files.

z Select multiple, nonconsecutive files by holding down the Control key and clicking on 
individual files.

3. Click the Zip Files button at the bottom.

Browse Parent Directory for Log Files
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Load Log Files (Emulation Mode Only)

To load log files:

1. Select File > Load Log File.

2. From the Open dialog box, navigate to the location the application is storing the .apd files (the 
default location is LogFiles > Activity in the installation directory).

3. Open the desired .apd and/or .zip file(s). The Status bar at the bottom indicates which file is being 
processed (for example, “Processing file 2 of 3”).

Activity Log

A diagnostics window where all activity is logged in detail keeps track of the application’s activity while 
it is running. The logging can be paused and resumed as required. The logged information can also be 
deleted (Clear Pad). The level of logging can be specified as: Critical, General (default), or Detailed.

To select options in the Activity Log:

1. Select Options > Show > Activity Log.

2. Click Pause Logging or Clear Pad as needed (change Log Level if desired).
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Communications
APDiagnostics communicates with a single enclosure at a time in Acquisition mode. (Only a single 
instance of the application can run on a PC when in Acquisition mode.)

Note: The Comm menu item is available only in Acquisition mode because communication with a 
system is not required to run APDiagnostics in Emulation mode.

The communication link can be disconnected at anytime (thus freeing up the Comm port for use by other 
applications) and then reconnected when needed. The program will reset itself when the reconnection 
occurs. Due to the potentially high volume of information being processed from the attached enclosure, 
we recommend using the Ethernet connection whenever possible. 

To change the Comm Settings (in Acquisition mode only): 

1. Select Comm > Settings.

2. Ethernet – Select the Ethernet tab and set the NIC ID.
Or
Serial Port – Select the Serial Port tab and set the 
Comm ID and baud rate.

3. Click Accept.
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Appendix D – Programmer’s Interface 
for System Diagnostics

System Component Information
The Epica DG displays system information in its splash screen* for diagnostic purposes. The 
information indicates the current status and well-being of the system components.

The splash screen can be accessed using a terminal emulation program, such as HyperTerminal
(see page 36). One of four verbosity** settings is specified to provide a level of detail for information on 
seven system components. Only one verbosity setting and one component setting can be entered in a 
command. The order in which the verbosity and component identity settings are entered is 
interchangeable.

Note: In a multiple-enclosure system, the splash screen displays information only for the enclosure 
that is connected directly to the PC.

* AMX reserves the right to add to the contents of the splash screen at any time, without notice.

** Verbosity (i.e., wordiness) refers to the amount of information provided; the higher the verbosity 
setting, the more information is displayed. 

FIG. 40  Example of a default Epica DG splash screen

Command entered to display minimal information 
for all system components

The system’s component identity numbers are 
to the left of each component 

~scr!

[1:Enclosure] AutoPatch Epica DG

[2:Storage Blocks] cleared

[3:Communication Interfaces] count = 3

[4:Hardware Boards] detected

[5:VM Configuration] count = 1

[6:Power System] good

[7:System Sensors] detected
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Verbosity Settings

The verbosity (v) settings (v0, v1, v2, v3) correspond to the level of detail that will be displayed, 
with v0 being the lowest level of detail and v3 being the highest level. 

Component Settings

Detailed information for a single system component can be specified by using its identity (i) number 
setting (i1 through i7) in the following table. Minimal information for all components can be specified 
by using the identity number i0. 

Default Settings

z At system boot, the ~scrv0i1 setting is displayed (see FIG. 18 on page 37).

z If the verbosity setting is omitted, the verbosity level will be the lowest (v0).

z The component setting must be included; otherwise, entering any of the verbosity settings 
alone will result in a display equivalent to v0i0. 

z If both settings are omitted during a query (~scr!), the information displayed will be at the 
lowest verbosity level for all components (v0i0) (FIG. 40 on page 91).

Using BCS to Access System Diagnostic Information
Instructions are provided for accessing the lowest level of verbosity for all components and for accessing 
a specific level of verbosity for a specific component.

To access the lowest level of verbosity for all components: 

1. Enter ~scr! or ~scrv0i0!

Note: Either of these commands provides a “menu” of the identity numbers and their corresponding 
components (FIG. 40 on page 91).

Only one verbosity setting and one component identity number can be entered in a command. The order 
in which they are entered is interchangeable.

To access a specific level of verbosity for a specific component:

1. Enter ~scr (to access the splash screen).

2. Enter the verbosity level setting v# and the component (index) setting i#. 
Either may be specified first.

3. Enter ! (to send the command).

Example 

~scrv3i6!  or  ~scri6v3! (Either displays the highest level of detail for the Power System.)

Component Identity Number

All Components i0

Enclosure i1

Storage Blocks i2

Communication Interfaces i3

Hardware / Boards i4

VM Configuration i5

Power System i6

System Sensors i7
92 Epica DG Instruction Manual



Appendix D – Programmer’s Interface for System Diagnostics
Splash Screen Examples

Following are four examples of splash screen information that could display when different 
verbosity/component settings are specified. Depending on the amount of detail provided, you may need 
to scroll to see the entire display.

FIG. 41  Display for v1i7 (verbosity 1, component 7)

FIG. 42  Display for v3i7 (verbosity 3, component 7)

FIG. 43  Display for v3i6 (verbosity 3, component 6)

~scrv1i7!

[7:System Sensors] detected

   [cpu pol] detected

   [io board 5 sensors] detected

   [center board 1 sensors] detected

   [center board 2 sensors] detected

   [fan controller 1] detected

   [fan controller 2] detected

~scrv3i7!

[7:System Sensors] detected

   [cpu pol] detected

      [temp] 51c

   [io board 5 sensors] detected

      [temp 1] 32.3c

      [temp 2] 33.9c

   [center board 1 sensors] detected 

      [temp 1] 28.5c

   [center board 2 sensors] detected

      [temp 1] 29.3c

~scrv3i6!

[6:Power System] good

   [status flags] 0x0000

   [available system power] 2418w

   [required system power] 990w

   [ac power slot 1] good

      [status flags] 0x0000

      [available power] 806w

      [output power] 150.850w

      [voltage] 12.248V

      [current] 12.248v
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FIG. 44  Display for v3i4 (verbosity 3, component 4)

~scrv3i4!

[4:Hardware Boards] detected

  [switching drivers] count = 4

    [mtx driver 1] M21151 144 x 144 driver

       [revision code] 0x4

       [product code] 0xc0

    [mtx driver 2] M21151 144x144 driver

       [revision code] 0x4

       [product code] 0xc0

    [mtx driver 3] M21151 144x144 driver
94 Epica DG Instruction Manual



Appendix E – Board Replacement
Appendix E – Board Replacement

This appendix covers the removal and replacement procedure for an Epica DG board. The procedure can 
be done while the system is powered up.

Important: Adding or replacing boards should only be done by personnel trained to handle ESD 
sensitive parts and assemblies.

Items Required

z Epica DG board(s)

z ESD wristband and cord with alligator clip

z Updated configuration file (see “Configuration Requirements” below to determine if the file is 
required)

Configuration Requirements

z If a board is replaced with the same type of board, the configuration file does not need to be 
updated.

z If a board is added to a previously empty slot as part of an unplanned upgrade or if a board is 
replacing a different type of board, a CD has been included with an updated configuration file, 
which must be uploaded to the system (see page 97) for the new board to work.

ESD Warning: To avoid ESD (Electrostatic Discharge) damage to sensitive components, make sure 
you are properly grounded before touching any internal Epica DG materials. Use an ESD wristband 
and cord with alligator clip attached to a good ground source.
95Epica DG Instruction Manual



Appendix E – Board Replacement
Replacing the Board
Important: Be sure to install the new board(s) in the correct slot (see the AutoPatch Connector 
Guide). The board’s location must match the system’s configuration information. If boards are 
installed in the wrong order, signal routing is affected.

To remove and replace an Epica DG board:

1. If applicable – Label and disconnect all cables on the board being replaced. If cables from adjoining 
boards obstruct access, label and disconnect them as necessary.

2. Blank board plate – Push out on the board plate’s extractor handles as far as they will go (about a 
45° angle), and then pull the blank plate straight out of the board slot opening.
Or
Current board – Push out on the board’s extractor handles as far as they will go (about a 45° angle). 
With the handles extended, carefully pull the board straight out of the board slot (FIG. 45). 
Place the board in an ESD approved static shield bag.

Caution: Each Epica DG board has an EMI (Electromagnetic Interference) gasket along the right 
edge of the face plate to ensure the boards fit snugly. Handle the boards carefully to avoid dislodging 
or damaging this gasket on the board being installed and on the board to its left.

3. Line up the new board on the board guides that are along the top and bottom of the board slot. With 
the board’s extractor handles in the extended position, carefully push the board firmly into the slot.

4. When the board is correctly lined up, as you push it in the extractor handles will start to fold toward 
the center of the board. Carefully push the board until it is seated firmly into the slot (when the 
board is correctly seated, the extractor handles will automatically move to the closed position).

FIG. 45  Push out on extractor handles and pull board out
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5. Open HyperTerminal and enter ~app! to do a soft reboot of the system.

6. Important – Update the system’s configuration file if necessary (see below).

If you need cabling information, see the specific board chapter in this manual.

Updating the System Configuration
The configuration file must be updated if:

z An input or output board is replaced with a different type of board.

z An input or output board is added to a previously empty slot and the system was not 
pre-configured for expansion.

The configuration file does not need to be updated if:

z An input or output board is replaced with the same type of board.

z An input or output board is added to a previously empty slot and the system was 
pre-configured for expansion.

If the system requires a new configuration file, the file is provided on a CD and needs to be loaded using 
XNConnect. We recommend keeping a copy of the former configuration file for reference.

To update the system configuration:
1. Attach a PC to the serial port on the Epica DG with an RS-232 null modem cable.

2. Install XNConnect from the AMX AutoPatch CD sent with the new board. (If XNConnect is already 
installed on the PC, we strongly recommend uninstalling the old version before installing a new 
version).

3. Open XNConnect.

4. From the Communication menu, select change Comm Settings. Check the settings for the selected 
PC port (the default is Com 1, baud rate 9600) and adjust if necessary.

5. From the File menu, select Open.

6. Using the standard File Open dialog box, locate and open the XCL (*.xcl) configuration file that 
was sent with the new board. The default location is in the C:\AutoPatch\Configuration 
Software<Version>\MyXCL folder.

7. From the Configure menu, select Configure All.

8. For XNConnect versions prior to 2.4.0 – from the Configure menu, select Reboot All Devices. 
(Version 2.4.0 automatically reboots the system.)

9. Execute a test switch that includes a signal routed on the new board to ensure the system is working 
correctly. (Repeat for any additional new boards.)
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